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Updating Search and Recover with WebUpdate

To keep your software in good working order, install product updates when they become available. Software updates address
compatibility issues, add features, expand existing functions and help to guarantee system security. Unfortunately, obtaining
software updates can be inconvenient and time-consuming.

To help you keep your jolo products up-to-date, we provide an extremely convenient and easy-to-use tool called iolo
WebUpdate ™. WebUpdate connects with our update server automatically over the Internet to ensure that your iolo software
products are kept up to date. WebUpdate lists any available updates and provides descriptions. It also reminds you to check for
updates, and can even download and install updates automatically for you. With WebUpdate, the process of staying up to date
becomes as simple as clicking a few buttons.

Using WebUpdate

To use WebUpdate, select the button labeled Options and Documentation, and then select the button labeled Check for
Updates in Search and Recover’s main screen. Once the main WebUpdate screen appears, select the button labeled Next to
connect to our update server and check for any available updates.

[# Note: If you have not yet registered Search and Recover with us, you will be prompted to do so before connecting to the update
server. You do not need to register, but it is highly recommended.

Configuring WebUpdate options
If you would like to change how WebUpdate operates, select the button labeled Options when executing the WebUpdate wizard.
A dialog appears, showing WebUpdate’s preferences. For more information about preferences, see WebUpdate: Options.

Downloading Updates
If updates are available, select the button labeled Next in the WebUpdate wizard to begin downloading them. You are presented
with a status gauge as well as an estimate of the time it will take to complete the download.

Installing updates
Once all of the updates are downloaded, select the button labeled Install Updates to install the newly downloaded updates.

Completing the update
Once Search and Recover has been successfully updated, select the button labeled Exit and Restart to close down Search and
Recover and restart it with the new updates.

[# Note: The Exit and Restart process may take up to a minute, and your computer may stop responding during this time. Please be
patient and do not interrupt this process.

Automatic updates
By default, WebUpdate automatically checks for updates every three days and notifies you if updates are available. This takes
place if you are connected to the Internet when Search and Recover starts up.

To change the frequency at which WebUpdate automatically checks for updates, select the button labeled Options in the first
WebUpdate wizard screen.

WebUpdate Options
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Uninstalling Search and Recover

Removing Search and Recover from your system:

1.  Select the Windows Start button, then select Settings, and then select Control Panel. (On Windows XP systems,
the Control Panel is available in the Start menu.)

In the folder or menu that appears, select and open Add/Remove Programs.
Select the entry labeled Search and Recover, and then select the button labeled Change/Remove.
Follow the prompts and dialogs that appear.
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Introducing the File Rescue Wizard

Search and Recover’s File Rescue Wizard makes data recovery fast and easy. The Rescue Wizard lets you perform data
recovery in three easy steps. Use the Rescue Wizard to selectively search your system for deleted items such as:

Documents

Pictures and images

Music, sounds, and video
Programs and applications
Web pages and related items

o 0 0 o0 0o

The Rescue Wizard also lets you perform a custom search using customized file patterns and wildcard characters.

To view each of the steps you perform to use the File Rescue Wizard, click on the links below:

1. Things to Search For

2. Places to Look
3. Recovering Files with File Rescue Wizard

Recovering Lost Files
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Recovering lost files

Introduction to data recovery

File Rescue Wizard

Advanced Deleted File Search
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Introducing the Advanced Deleted File Search

Search and Recover’s Advanced Deleted File Search screen gives you extra tools that help you locate and recover lost files,
allowing greater control over the search for lost files and the management of recovered files.

Use Advanced Deleted File Search if you:

q

o o0 o o

Want to specify your search criteria in great detail
Need to recover the contents of a deleted folder
Need to use different sets of search criteria

Want to view or retrieve contents of a deleted file
Need a flexible, powerful recovery tool

To start using Advanced Deleted File Search, select the button labeled Advanced Deleted File Search in Search and Recover’s
main screen. Once the Advanced Deleted File Search screen appears, you can start your search.

See Setting up search criteria.

Also see Advanced Deleted File Search menus.

* IMPORTANT: To maximize the chances of successful recovery:

q
q

Always use Search and Recover as soon as you know you need to recover a file.
Always recover files to a different drive or partition, if one is available.

Click here for more information about safe recovery concepts

Return to Advanced Deleted File Search
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Using the Advanced Deleted File Search: Locations to Search

To select the drives, partitions and devices that you want to include in your search for deleted files, use the tab labeled
Locations in the Search Options dialog that appears when you execute a new search in the Advanced Deleted File Search
screen.

At the top of this tab, you see a list of drives, partitions and devices that can be searched for recoverable data, including floppy
drives, hard drives, removable drives, USB storage devices, and any other devices that have a corresponding drive letter in
Windows (see setting up a removable device for scanning).

To include a drive or device in your search, select its corresponding button in the list of devices that appears in the Locations tab.

Refreshing the list of devices and drives
If a device (for example, a removable drive, CD-RW, MP3 player, or digital camera) does not appear in the window, make sure it
is connected to your computer with the appropriate cable (for example, a serial, parallel, or USB cable), and ensure that it

appears as a device in My Computer in Windows. Once the device is installed and available in My Computer, select the button
labeled Rescan Drive List in the Location tab to display the new device in the list of available drives and devices.

Narrowing your search scope by searching specific folder locations

To include a specific folder in your search, select the button labeled Add Location.

Scanning subfolders

To scan subfolders in a selected location, select the button labeled Edit Selected.

Removing locations

To delete a selected location from the list of locations to scan, select the button labeled Remove Selected. You can also exclude
the selected location from the current scan by deselecting its corresponding button.

Return to Advanced Deleted File Search
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Using the Advanced Deleted File Search: Condition

When Search and Recover scans a drive, partition or folder for deleted files, it assesses the probability of recovering the entire
file.

A Good probability means that there is a very good chance that the original file’s data is still intact and that it has not been
overwritten by another application.

A Moderate probability means that although much of the original data within the deleted file is intact, it is likely that at least a
small portion of the file has been overwritten by another application.

A Poor probability means that most, if not all, of the file has been overwritten, the cluster itself may be corrupt, or the partition
table did not properly record the chains linking files to clusters.

By default, all files appear in the search results screen, regardless of the probability of recovery. Deselect the selection buttons
beside undesired files and folders in order to show only the files you that want.

[# Note: The probability of file recovery, and the amount of damage to a file, affects different types of files in different ways. For
example, a Windows executable file (.exe) usually requires that the entire file be 100% intact in order to execute. A document or
picture can be partially recovered and may still be useful even though much of its original data is lost or corrupted. (For example, a
specific telephone number or password may still be intact even within a heavily damaged, deleted file.)

[ Note: Although Search and Recover uses advanced techniques to determine the state of a deleted file, there is no completely
accurate method of determining file integrity. The condition indicator provided in Search and Recover shows a probable state, and is
not a guarantee. You must attempt a full recovery before you can be certain of the condition and recoverability of a deleted file.

Return to Introduction to Data Recovery
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Using the Advanced Deleted File Search: Size

Select the button labeled Only find items with certain sizes in tab labeled Size in the Search Options dialog if you would like to
narrow your search to files that fall into a specific size range. By default, the Advanced Deleted File Search screen displays all
the deleted files it can identify, regardless of size.

To set a minimum size, select the button labeled Greater than and either type in a size or use the arrow buttons to limit any
displayed items to those whose size is greater than that indicated in this field. To change the scale, select the button to the right
of the numeric value and then choose either kilobytes, megabytes, or gigabytes.

For example, to limit the search to items greater than 5 megabytes, enter 5 in the field labeled Greater than and then select
the button labeled KB and change the value to MB.

To set a maximum size, select the button labeled Less than and either type in a size or use the arrow buttons to limit any
displayed items to those whose size is less than that indicated in this field. To change the scale, select the button to the right of
the numeric value and then choose either kilobytes, megabytes, or gigabytes.

For example, to limit the search to items less than 10 megabytes, enter 10 in the field labeled Less than and then select the
button labeled KB and change the value to MB.

To limit your search to files within a range of sizes, select both buttons and specify both a minimum and a maximum size.

Return to Advanced Deleted File Search
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Using the Advanced Deleted File Search: Attributes

Every file and folder has attributes assigned to it. By default, Advanced Deleted File Search ignores a file’s attributes during a
search. If you know that the files you are looking for have — or do not have — a particular attribute, you can limit the search using
that attribute.

To limit your search to files that have or do not have specific attributes, select the button labeled Only find items with the
following attributes in the tab labeled Attributes in the Search Options dialog.

Any vs. All
To limit your search to files that have any of the specified attributes, select the button labeled Any of the following. This will
include all files that have any of the specified attributes. A file will match if it has any one of the specified attributes.

To limit your search to files that have all of the specified attributes, select the button labeled All of the following. This will
include only those files that have all of the specified attributes. For example, if the Read Only and System attribute buttons are
selected, a file that has the Read Only, System, and Archive attributes will appear, but a file that has only the System attribute
will not appear.

File attributes are:

Read Only
Files marked with this attribute can be read and viewed, but cannot be changed.

Hidden
Files marked with this attribute do not appear in Windows Explorer. They are usually not intended to be modified by a
user, and may be critical to the operating system.

System
Files marked with this attribute are usually very critical to the operating system, and in most cases are required in order
for Windows to start up.

Archive
Files are marked with this attribute when they are created or modified. Some backup programs use this attribute to keep
track of when a file has been backed up.

Hiding or showing folders that do not contain any deleted data

Search and Recover can display your entire folder structure in the Folder Pane when a search is complete. This lets you easily
see where a deleted file or folder is located on a drive or partition. Most of the time however it is helpful to hide all folders from
your search results unless the folders either contain deleted data within them or their subfolders, or are themselves deleted
folders.

To hide other folders, select the button labeled Hide folders that are not deleted and do not hold any deleted items.

Return to Advanced Deleted File Search
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Using the Advanced Deleted File Search: Dates

Options on the tab labeled Dates in the Search Options dialog let you narrow your search based on the dates on which files or

folders are created, changed (modified) or accessed. By default, Search and Recover does not restrict search results based on
date. If you would like to find files and folders based on a specific date range, select the button labeled Only find files between
certain dates.

Selecting the type of qualifier to apply to the date criteria

When searching for files that fall within a certain date range, decide whether you are interested in files that were modified,
created or accessed in that date range:

Modified
The date when the file was last changed.

Created
The date when the file was created. This may be the installation date, the download date, or the date when you originally
created a file or document with this name.

Last Accessed

The date when the file was last opened. This may correspond to the last time it was opened for editing, the time when an
application (such as an antivirus program) scanned or accessed it, or the time when a utility such as Windows ScanDisk
last checked to see if the file could be opened.

Selecting the date range to apply to the search

In the last ____ month/day

Select the button labeled In the last __ month/day in order to include any files that were modified, created or last accessed
within the specified amount of time. To change the timescale, select the buttons labeled month(s) or day(s). To increase or
decrease the number of months or days specified, enter the number in the corresponding field, or use the up and down
arrows.

Between a certain date range

If the files or folders you are searching for were modified, created or last accessed during a certain known period of time,
select the button labeled Between and enter start and end dates in the associated date fields in order to find those files or
folders more easily. The search results will contain only files that were created, modified, or last accessed within the
specified date range.

By default, today’s date appears in each field. If left unchanged, this limits the search to find only those files and folders that
were created, modified or last accessed today. Type in the beginning and end of the date range in each field, or select the
drop-down menu to display a calendar.

Return to Advanced Deleted File Search
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Using the Advanced Deleted File Search: Files

Use the tab labeled Files in the Search Options dialog to narrow your search based on file type or file name. By default, the
button labeled Find all file types is selected, and the search will identify all deleted files regardless of file type.

Select the button labeled Find certain file types in order to narrow the search.

You can define an inclusive search (Only find the following), or an exclusive search (Exclude any of the following).
Search based on file names or text in the files.

Make the search case sensitive (so that MyFile.txt is treated differently from myfile.txt) by selecting the button labeled Case
Sensitive.

g Select the button labeled Search for specific registered Windows file types. Select the appropriate button for the kind of
files you want to find. If the file type you are looking for is not listed in Common Groups, select the button labeled
Individual types to locate the type that you want.

TIP: Use wildcards when doing a file name search. When a file is deleted on Windows 95, 98 and ME systems, the first letter of
the file name disappears when a file is deleted. Wildcarding the first character of the filename ensures that you will find matching
files regardless of a missing first character.

Return to Advanced Deleted File Search
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Using the Advanced Deleted File Search: Exclusions

A search through a large hard drive may generate irrelevant hits from the contents of cache folders, including your Internet
Explorer cache. Use the tab labeled Exclusions in the Search Options dialog to skip these cache folders (and any other folders
that you want to specify).

1. Select the button labeled Exclude the following locations from a search to exclude a drive or folder.

2. Select any of the Windows browser folders buttons to skip those folders.

q

The browser cache (also known as the Temporary Internet Files folder) is where Internet Explorer stores the
contents of web pages you visit so that the page loads faster when you return to it. Each type of web browser
places its cache folder in a different location on your hard drive. Select the button labeled Windows browser
cache folders to exclude the Internet Explorer cache folder from your search.

Internet Explorer clears its cache periodically. There are times when it may be useful to search the cache for
deleted files. In most cases, however, searching the cache is not helpful.

Browser cookies are small text files that identify you to web sites that you visit. They rarely contain information
valuable to a user, and many cookies are deleted each time you close your browser or shut down Windows.
Excluding cookie folders may help provide a faster search. Select the button labeled Windows browser
cookie folders to exclude the Internet Explorer cookie folder from your search. As with the cache files, if you
use a browser other than Internet Explorer, you need to add the location of that browser’s cookie folder in
order to exclude it.

Browser history folders contain the addresses of web sites you have visited recently. This folder is cleaned out
periodically. If you want to find a web address that may have been cleaned out of your History folder, try
including History in your search. Otherwise, select the button labeled Windows browser history folders to
exclude the Internet Explorer history folder from your search.

3. Select the button labeled Add Location to specify any other folders (for example, C:\Program
Files\Netscape\Users\username\Cache). Type in the complete path to the folder yourself, or select the folder icon to
the right of the field to browse to the folder. Add a description for the folder (for example, Netscape cache) in the
second field. Select the button labeled OK to add the location to your excluded list.

Return to Advanced Deleted File Search
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Using the Advanced Deleted File Search: Saving search profiles

Use the tab labeled Search Profiles in the Search Options dialog to save your search criteria for later use.

To save a search

1. Type a name for the search in the top field. Name the search so that it will be easy to find and use later. (For example,
if you have set your criteria to search only for documents larger than 100 KB, you could call the search "Docs 100KB
plus".)

2. Select the button labeled Save. The profile name appears in the bottom field.

To load a saved search file

1. Use the drop-down menu to select from a list of all your search profiles.
2. Select the button labeled Load to retrieve the selected search criteria.

To delete a search profile

1. Use the drop-down menu to select from a list of all your search profiles.
2. Select the button labeled Delete to remove the selected profile from the list.

Return to Advanced Deleted File Search
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Using the Advanced Deleted File Search: Working with deleted files and folders

Two areas in the Advanced Deleted File Search screen display lists of files and folders that match your search criteria.

Folder Pane
The Folder Pane in the left portion of the Advanced Deleted File Search screen displays a hierarchy of folders on the devices,
drives or partitions that you have searched. The folder icons indicate the status of each folder.

File Pane
The File Pane in the top right portion of the Advanced Deleted File Search screen displays a list of matching files with their
characteristics.

Previewing a file in the Viewer Pane
To view the contents of a file, select it in the File Pane. The file’s contents appear in the Viewer Pane.

Four tabs at the bottom of the Viewer Pane let you select the type of view appropriate to your data:

Raw Contents
ma
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Using the Advanced Deleted File Search: Printing recovered files

You can print a deleted image, the raw contents of a deleted file, or selected text from deleted files.

To print

1. Once you have performed a search and found the desired file, select the file in the File Pane.
2. Select the File menu, and then select the content you wish to print:

Print raw contents: Select this option to print the hexadecimal or ASCII contents of the file. You can choose to print

the current cluster, a range of consecutive clusters (that is, you can print Clusters 1-10 with this option, but not 1, 4, 9
and 10), or the entire file. One cluster will appear on each page. Select the button labeled Print Preview to see how

the data will look.

Print selected image: If the file is a picture, print it by selecting this option. Print the image as is, or scaled to fit the
width of your paper. Select the button labeled Print Preview to see how the image will appear.

Print text in selected item: Select this option to print all the text in the file.

3. When you select the button labeled Print, the selected item prints.

Advanced Deleted File Search
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Using the Advanced Deleted File Search: Copying recovered data to the
clipboard

To paste recovered data into other applications:

Select the desired file in the File Pane..
Select the text or other content you want to copy.

3. Select the Edit menu (either at the top of the Advanced Deleted File Search screen, or in the Preview Pane), and then
select a copying option:

q Copy selected raw text to clipboard: This option appears in Raw Contents View and puts the text from the
right column on the clipboard. This is useful if a file contains corrupt or overwritten data, but also contains some
intact information.

q Copy selected hex values to clipboard: This option appears in Raw Contents View and puts the selected
hexadecimal or ASCII information on the clipboard. This is useful if a file contains corrupt or overwritten data,
but some valuable information remains intact.

g Copy selected preview data to clipboard: This option appears in HTML View and Text View, and puts your
data selection onto the clipboard.

g Copy picture contents to clipboard: This option appears in Image View and puts the selected image onto
the clipboard.

Return to Advanced Deleted File Search
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Using the Advanced Deleted File Search: Refining a deleted files search

Once you have completed a system search, you can use the Search menu to focus your search and reduce the number of files
that appear in your search results.

Modifying the search filter

If you have too many items in your search results (or if you are not seeing all the files you expect), you can modify your search
filter to include or exclude additional files. Select the Search menu and then select the item labeled Modify Search Filter For
Currently Selected Items to open the Search Options dialog. Use the panes in the Search Options dialog to narrow the
search criteria.

When you have made the required changes, select the button labeled Search to apply your new criteria to the current results.

Execute the search again

If you did not find the files that you expected to find, select the Search menu and then select the item labeled Re-scan Currently
Displayed Locations. This executes the search again, and may identify files that have changed since you first ran the search.

Searching your results for folder and file names

To search for file or folder names in your search results, select the Search menu and then select the item labeled Search For
File And Folder Names. A Find Text Pane opens in the upper right portion of the Advanced Deleted File Search screen, letting
you search for file or folder names within your search results.

In the Find Text Pane:

Type all or part of the file or folder name in the field labeled Text to find.
Specify whether you want to search for files, folders or both by selecting the appropriate button.

3. Select the button labeled Search. Advanced Deleted File Search searches through the drives and folders in the current
search results in order to locate matching files, or the first matching folder. The files matching the search, or the files
contained in the folder matching the search, appear in the File Pane.

4. If you are searching for folders, select the button labeled Next to proceed to the next matching folder. Repeat until you
find the item for which you are looking.

Searching your results for text within files

To find text within the deleted files found by the Advanced Deleted File Search, select the Search menu and then select the item
labeled Find Text In Contents Of Found Files.

Use this function with Advanced Deleted File Search’s Save, Copy, and Print functions in order to recover specific sentences,
phrases and paragraphs from a deleted file without having to recover the entire file. For more information, see Finding Text in
Files.

Starting a new search

To start over with a new search, select the Search menu and then select the item labeled Start A New System Search to open
the Locations pane of the Search Options dialog. Once you enter your new search criteria in the Search Options dialog, select
the button labeled Search.

Return to Advanced Deleted File Search
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Using the Advanced Deleted File Search: Restoring deleted files
There are three ways to recover files from the Advanced Deleted File Search screen and to save the data to a new file:
1. Use the Recover menu.

2. Use the context menu.
3. Drag and drop the file.

* IMPORTANT: To maximize the chances of successful recovery:
g Always use Search and Recover as soon as you know you need to recover a file.
g Always recover files to a different drive or partition, if one is available.

More information here

Using the Recover menu to save data to a new file

1. Select the files you want to restore. Highlight a file name to select that file for recovery. To select multiple files, hold
down the Ctrl key while you highlight each file. To select all files in the list, select one file in the list and then press
Ctrl-A.

2. Select the Recover menu (or select the button labeled Recover in the toolbar) and then select the item labeled
Selected Item.

3. Browse to the folder into which you want to place the recovered files. To create a new folder, select the parent folder,
and then select the button labeled New Folder. Type the name of the folder in the field. When you have selected the
folder, select the button labeled OK.

4. If there are other files that you want to recover to a different folder, repeat the above steps.

Recovering files using drag and drop
Open Windows Explorer.

2. Inthe Advanced Deleted File Search screen, select the files you want to restore. (Highlight a file name to select that
file.) To select multiple files, hold down the Ctrl key while you select each file. To select all files in the list, select one file
in the list and then press the Ctrl-A key.

3. Drag and drop your selection into a folder on another drive or device in Windows Explorer.

Using a context menu to recover files

1. In the Advanced Deleted File Search screen, select the files you want to restore. (Highlight a file name to select that
file.) To select multiple files, hold down the Ctrl key while you select each file. To select all files in the list, select one file
in the list and then press the Ctrl-A key.

2. Right-click on any selected file name. A context menu appears. Select the item labeled Recover Selected to choose
the folder to which you want to recover the files.

3. Browse to the folder in which you want to put the recovered files. To create a new folder, select the parent folder, and
select the button labeled New Folder. Type the name of the folder in the field. When you have selected the folder,
select the button labeled OK.

See Restoring folders to another location.

Return to Advanced Deleted File Search

Return to Search and Recover Help Topics




Using Security Functions: Terminating deleted files

To make already-deleted files unrecoverable using the Advanced Deleted File Search screen:

Select the files that you want to permanently remove from your system.
2. Select the Security menu, and then select Clean and Sanitize Selected Entries.

File Terminator overwrites the deleted files repeatedly. You can set the number of overwrites in the File Terminator
screen or in the Options dialog available from the Advanced Deleted File Search screen.

See File Terminator.

Return to Advanced Deleted File Search
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Using the Advanced Deleted File Search: Raw Contents view

The Raw Contents view is a literal representation of the data exactly as it is found on the disk, in hexadecimal or ASCII text
format. This view is useful if the file is incomplete or otherwise corrupted.

The Viewer Pane provides several ways to navigate through the file contents and restore data.

Navigating through raw contents

The following navigational aids are activated if the selected or previewed file is larger than one formatted cluster:

g First: Select the button labeled First to display the first cluster containing the selected file.

g Previous: When you are deeper into the file, select the button labeled Previous to display the previous cluster
containing the selected file.

Next: Select the button labeled Next to proceed to the next cluster containing the selected file.
Last: Select the button labeled Last to proceed to the last cluster containing the selected file.

Go to Cluster: Select the button labeled Go to Cluster to jump to a specific cluster containing the selected file. A
dialog opens. Type in the number of the cluster you would like to see. For example, if you would like to see the third
cluster containing the file, type 3.

Finding text

Select the button labeled Find to locate text in the file.

Recovering files

Select the Edit menu in order to

g save this information (or a selection) to another location
g copy to the clipboard
g print file contents

Options menu

To control the contents of the Viewer Pane, select the Options menu.

Return to Advanced Deleted File Search
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Using the Advanced Deleted File Search: Image view

When you select an image to recover, the Image view displays image files.

Select the button labeled Stretch Image to expand (or compress) the image so that it fills the entire pane.

Select the Edit menu in order to

q
q
q
q

save the picture to another location

convert the image from one format to another (select the item labeled Save Picture As).
copy to the clipboard

print file contents

Options menu

To control the contents of the Viewer Pane, select the Options menu.

Return to Advanced Deleted File Search
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Using the Advanced Deleted File Search: HTML view

The HTML view displays text and HTML as it would appear in a browser.
Select the button labeled Find to locate text in the selected file.
Select the Edit menu in order to

g save this information (or a selection) to another location
q  copy to the clipboard
g print file contents

Options menu

To control the contents of the Viewer Pane, select the Options menu.

Return to Advanced Deleted File Search
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Using the Advanced Deleted File Search: Text view

This view displays text only.
Select the button labeled Find to locate text in the selected file.
Select the Edit menu in order to

g save this information (or a selection) to another location
q  copy to the clipboard
g print file contents

Options menu
To control the contents of the Viewer Pane, select the Options menu.

Return to Advanced Deleted File Search
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Using the Advanced Deleted File Search: Options

To control the display of information and the methods used to recover files, set the Advanced Deleted File Search options. Select
the Options menu, and then select the item labeled Edit General Options. Select one of the following tabs in the General

Options dialog:

g Contents Preview

g Security Functions

g Batch Recovery

g Drag and Drop

g Recovery
g Logging

Return to Advanced Deleted File Search
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Using the Advanced Deleted File Search: Contents Preview options

Use the tab labeled Contents Preview in the General Options dialog to control the display of files in the Viewer Pane. To open
the General Options dialog, select the button labeled Options in the Advanced Deleted File Search screen.

Select one of the following buttons:

g Automatically display supported file types in their native format: Select this button in order to display most files in
their native format within the Image, HTML and Text views. Deselect this button in order to speed up the display of data
by disabling native format display.

g Maximum size for HTML preview: Select this button in order to speed up your system by limiting the preview of HTML
data. Previews will appear only for files that are smaller than the size specified in the associated Maximum Size field.
By default, the maximum is set at 200 KBytes.

g Maximum size for text preview: Select this button in order to speed up your system by limiting the preview of text data.
Previews will appear only for files that are smaller than the size specified in the associated Maximum Size field. By
default, the maximum is set at 500 KBytes.
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Using the Advanced Deleted File Search: Drag and Drop options

You can drag and drop files from Advanced Deleted File Search into Windows Explorer, but you cannot drag and drop entire
folders.

To determine how Advanced Deleted File Search handles folders that you try to drag and drop, use the tab labeled Drag and
Drop in the General Options dialog. To open the dialog, select the button labeled Options in the Advanced Deleted File Search
screen.

Select one of the following buttons:

g Display a warning and abort the drag operation: Select this button if you want to be reminded not to select folders
when dragging. You cannot complete a file recovery if folders are selected.

g Deselect any selected folders and continue: Select this button to remove any selected folders before you drop your
files. Select this button if you would like a visual clue that folders cannot be transferred.

g Leave folders selected and process any other items: This is the default, and offers the most flexibility. Select this
button if you do not wish to receive any indication that selected folders will not transfer to the new drive.

Return to Advanced Deleted File Search
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Using the Advanced Deleted File Search: Recovery options

Use the tab labeled Recovery to manage potential problems with the names of recovered files. To open the dialog, select the
button labeled Options in the Advanced Deleted File Search screen.

1.

When you copy a file to a different drive, you may encounter another file with the same name. The first section of the
Recovery tab determines how Search and Recover handles duplicate files.

q

q

Append a number to the new file: Select this button to keep the existing file in the folder, and to rename
the recovered file to filename1.abc. This is the default.

Overwrite the existing file: Select this button to delete the existing file and replace it with the recovered
file.

Prompt for a new file name: Select this button in order to be prompted to name the recovered file.

In Windows 95, 98 and ME, the first letter of a deleted file’s name disappears when it is deleted, and is replaced by a
question mark (?). The following options determine how files with a missing first letter are handled.

q

Automatically substitute the following text: Select this button to choose another character to represent
the missing one. By default, a hyphen (-) is used if this button is selected. (For example, the recovered file ?
aleschart.xls will become —aleschart.xls.)

Omit the first character: Select this button to drop the first character and start the file name with the
second character. (For example, the recovered file ?aleschart.xIs becomes aleschart.xls.)

Prompt for a character: This is the default option. Select this button if you want to be prompted to enter the
missing character. (For example, the recovered file ?aleschart.xls becomes saleschart.xls, when you enter
the character s.)

For very long file names (exceeding 255 characters), you can specify a string of up to 12 characters to indicate that the
file name is truncated. By default, this string is [TRUNCATED].

Warn if undeleting a file to its source drive: We highly recommend recovering a file to a different drive than the
drive where it was originally stored. Leave this button selected to remind you when you try to restore to the original

drive.

Return to Advanced Deleted File Search
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Using the Advanced Deleted File Search: Batch Recovery options

Use the tab labeled Batch Recovery to manage potential problems with the names of recovered files when recovering multiple
files (or the contents of a folder). To open the dialog, select the button labeled Options in the Advanced Deleted File Search

screen.

1. When you copy a file to a different folder or drive, you may encounter problems when a file with the same name
already exists there, or has been copied there. The following options control the handling of duplicate file names:

q

Append a number to the new file: Select this button to keep the existing file in the folder, and to rename
the recovered file to filename1.abc. This is the default.

Overwrite the existing file: Select this button to delete the existing file and replace it with the recovered
file.

Prompt for a new file name: Select this button in order to be prompted to name the recovered file.
Abort undeletion of individual file: Select this button to stop the recovery of the file.

5. In Windows 95, 98 and ME, the first letter of a deleted file’s name disappears when it is deleted, and is replaced by a
question mark (?). The following options determine how files with a missing first letter are handled.

q

Automatically substitute the following text: Select this button to choose another character to represent
the missing one. By default, a hyphen (-) is used if this option is selected. (For example, the recovered file ?
aleschart.xls will become —aleschart.xls.)

Omit the first character: Select this button to drop the first character and start the file name with the
second character. (For example, the recovered file ?aleschart.xls becomes aleschart.xls.)

Prompt for a character: This is the default option. Select this button if you want to be prompted to enter the
missing character. (For example, the recovered file ?aleschart.xls becomes saleschart.xls, when you enter
the character s.)

6. For very long file names (exceeding 255 characters), you can specify a string of up to 12 characters to indicate that the
file name is truncated. By default, this string is [TRUNCATED].

7. Warn if undeleting a file to its source drive: We highly recommend recovering a file to a different drive than the
drive where it was originally stored. Leave this button selected to remind you when you try to restore to the original

drive.
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Using the Advanced Deleted File Search: Logging options

When recovering multiple files and folders at the same time, consider logging the recovery information in a text file.

Use the tab labeled Logging in the General Options dialog to manage recovery logging. To open the dialog, select the button
labeled Options in the Advanced Deleted File Search screen.

q

Name: The names of recovered files are logged. In addition to the full file name (or the file name minus the first character),
the file type is also logged if it can be identified.

File Size: Select this button to log the sizes of recovered files.
Last Modified date: Select this button to log the date on which the file was last changed or saved.

Last Accessed date: Select this button to log the date on which recovered files were last opened. This could be when you
opened a file for editing, when your antivirus program scanned the file, or when ScanDisk checked to see if the file could be
opened.

File Attributes: Select this button to log the file attributes associated with recovered files.

The log is stored in the Search and Recover install folder (C:\Program Files\iolo\Search & Recover is the default).

* IMPORTANT: |If you are recovering data from the same partition that Search and Recover is installed on, the log file may
overwrite the data you want to recover.

More information here
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Switching between Search and Recover tools

To switch between the Advanced Deleted File Search screen and the four Email Recovery tools, select the Recovery Tool
Windows menu, and then select the tool you want. (You do not have to return to the main Search and Recover screen.)

Return to Advanced Deleted File Search
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Introduction to Email Recovery

Email messages are not erased from your hard drive when you delete them. When you delete messages within your email
application, deleted messages usually remain stored in your mailbox until you compress the mailbox itself. If you have lost
important email messages, Search and Recover provides tools to help you recover those messages. Search and Recover
supports the four most popular email applications.

[ Note: If you have deleted an entire mailbox file, first use File Rescue Wizard or Advanced Deleted File Search to recover the
mailbox file. When the mailbox file is restored, you can then use the Email Recovery tools to recover individual messages that you
deleted within you email application, if necessary.

Email Recovery Help Topics
g Recovering Outlook Express email

g Recovering Microsoft Outlook items

q Recovering Qualcomm Eudora email

g Recovering Netscape/Mozilla mail

See Tips for successful email recovery.

Also see Changing the Netscape Mail profile.
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Using Email Recovery: Outlook Express recovery

Outlook Express Help Topics

g Recovering Outlook Express messages
Opening a mail folder
Opening a recovered message in Outlook Express
Saving a message to a file

g Locating an Outlook Express message
Sorting message headers

Searching for text in Subject lines

g Copying a message to the clipboard
Selecting and copying message text

Pasting text in another document

g Restoring a saved message to your Outlook Express inbox
Opening a saved message in Outlook Express

Using the Move to Folder command

Tips for successful email recovery
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Using Email Recovery: Recovering Outlook Express messages

To recover a deleted message from Outlook Express:

Select the button labeled Recover Lost Email in the Search and Recover main screen.
Select the button labeled Microsoft Outlook Express in the Email Recovery Options screen.

3. Search and Recover locates your Outlook Express root message folder and displays its contents in the Folder Pane
on the left side of the Recover Deleted Email screen. If this folder does not display the right mailbox, select the button
labeled Open Mail Folder. A browse dialog appears.

In nearly all cases, your mailbox will be located under C:\Windows\Application Data (or C:\WinNT\Application Data
in Windows NT/2000). When you have located the correct mailbox, select the button labeled OK to display its folders.

4. Select the + sign next to Local Folders (or select Local Folders and press the Enter key) to expand the folder list,
then select Inbox. Messages deleted from this folder appear in the right pane.

5. Select a message that you wish to recover. Its contents appear in the Viewer Pane in the lower right of the screen.

TIP: You may select multiple messages, but the contents will not be previewed.

6. Select the button labeled Recover. Use the Browse dialog that appears to select a location for the recovered message
files. Select the button labeled OK to recover your messages. Each message is saved as <MessageSubject>.eml. You
can open recovered messages by opening the message file. Message files open in the email application set as the
default on your system (although they will not appear in the Outlook Express inbox, if opened in Outlook Express).

7.  If you want to move the message back into an Outlook Express message folder, use one of the following two methods:

g Select the button labeled Open in the Outlook Express toolbar and navigate to the message file. Once
you have opened the message file in Outlook Express, select the File menu, and select the item labeled
Move to Folder. Select Inbox (or any other folder in which you want to place the message), and then
select the button labeled OK.

g Drag the message file from Windows Explorer into the open Outlook Express message box, and drop it
there.

[# NOTE: When you delete a message with a file attachment in Outlook Express, the attachment may be unrecoverable.

Return to Outlook Express Recovery
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Using Email Recovery: Searching for specific deleted messages in Outlook
Express

If you have a large number of messages in the Message Pane, there are two ways you can find the message you are seeking:

Searching the Subject line
Select the first message in the Message Pane.
Select the button labeled Search in the toolbar (or press Ctrl-F) to search the Subject line.

Type a word or phrase in the field labeled Find what. Select the button labeled Find Next to locate the first message
matching your word or phrase.

4. Press the F3 key to locate the next message matching your word or phrase. Repeat F3 until you find the right
message.

Sorting the message headers
Select any column heading in the Message Pane to sort the message list by that column. For example, if you need to find a
message from iolo technologies:
1.  Select the button labeled From at the top of the From column. A small triangle appears in that column. If the triangle
points up, messages appear in alphabetical order. Select the column heading again to reverse the order.
2. Scroll down the list to find the message from iolo technologies. Select the message that you wish to recover.

Return to Outlook Express Recovery
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Using Email Recovery: Restoring a saved message to your Outlook Express
inbox

When you save an Outlook Express message as a file, the message file opens in Outlook Express, but does not appear in your
Inbox’s list of messages. To restore the message to the Inbox list, perform the steps below:

After you have recovered a message using Search and Recover, locate your message in Windows Explorer.
Double-click the message to open it.

Select the File menu, and then select the item labeled Move to Folder.

Select Inbox (or any other folder you want this message moved into), and then select the button labeled OK.

a k0N~

The next time you open Outlook Express, your message appears in the folder that you selected.

See Copying Message Text to the Clipboard.
Also see Switching between Search and Recover Tools.
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Using Email Recovery: Recovering Microsoft Outlook items

Microsoft Outlook handles mail very differently than other email client applications. All your email messages, tasks, calendar
items, contacts and notes are stored in a single file, usually called Outlook.pst. Search and Recover restores all deleted items
to your Outlook mailbox at once.

To recover deleted items in Outlook:

oo b~

Make sure Outlook is closed, then launch Search and Recover.
Select the button labeled Recover Lost Email in the Search and Recover main screen.
Select the button labeled Microsoft Outlook in the Email Recovery Options screen.

Search and Recover tries to identify the location of your Outlook.pst file. If this does not appear in the upper field,
select the folder icon to the right of the field to locate the file yourself. Browse to the Windows folder (C:\Windows or
C:\WinNT) and look in Local Settings\Application Data\Microsoft for the PST file.

By default, Search and Recover makes a backup of your PST file for safekeeping. We strongly recommend that you do
not change this default setting. In the unlikely event of an abrupt interruption in the recovery process (due to a power
surge or some other problem), you can revert to your original mail file by replacing it with this backup. To change the
location of the backup, either type in a path or select the button labeled Browse to store the backup elsewhere.

Select the button labeled Start to recover all items. Search and Recover displays a progress bar as it locates and
restores all deleted items from your Outlook.pst file. It then reports on its success. When you re-open Outlook, the
items are restored to their original locations.

See Switching between Search and Recover Tools.
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Using Email Recovery: Qualcomm Eudora recovery

Qualcomm Eudora Recovery Help Topics
q Recovering Qualcomm Eudora messages
Opening a mail folder
Selecting a mailbox
Resurrecting a message
Saving a message as a file

g Locating a Eudora message
Sorting message headers

Searching Subject lines

g Copying message text to the clipboard
Selecting and copying message text

Pasting text in another document

Tips for successful email recovery
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Using Email Recovery: Recovering Qualcomm Eudora messages

To recover a deleted message from Eudora:

PN =

Make sure Eudora is closed, then launch Search and Recover.
Select the button labeled Recover Lost Email in the Search and Recover main screen.
Select the button labeled Qualcomm Eudora in the Email Recovery Options screen.

Search and Recover locates your root mail folder and displays its contents in the Folder Pane on the left side of the
Recovered Deleted Email screen. If this folder does not display the right mailbox, select the button labeled Open
Mail Folder. A browse dialog appears. By default, Eudora stores message data in the Eudora install folder (C:
\Program Files\Qualcomm\Eudora), but you can reset that location in Eudora’s settings. When you have located the
correct mailbox folder, select the button labeled OK to display its folders.

Select the mailbox in which you want to search. (In is a good place to start.) Search and Recover identifies deleted
messages in the selected folder. A progress bar appears as the search continues, and messages appear in the upper
right Message Pane. You can stop a search at any time by selecting the button labeled Cancel.

TIP: If you use filters to sort your mail into different folders, select appropriate folder button when searching for that
mail.

Search and Recover displays messages deleted from the selected folder in the right pane.

If you want to manage the Read status of recovered messages, select the button labeled Options, and then in the
drop-down menu that appears, select the item labeled Mark Recovered Items as Read to mark the recovered
messages as read, or select the item labeled Mark Recovered Items as Unread to mark the recovered messages as
unread.

Use one of the following two methods to recover your messages:

q Select the button labeled Resurrect at the top of the Recover Deleted Eudora Messages screen to recover
the selected messages to the Eudora folder in which they were found.

q Select the button labeled Save at the top of the Recover Deleted Eudora Messages screen to recover the
selected messages and store them as files outside of Eudora. Use the Browse dialog that appears to identify
the folder in which you want to place the message files. Message files open in the email application set as the
default on your system.

See Copying Message Text to the Clipboard.

Also see Switching between Search and Recover Tools.
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Using Email Recovery: Searching for specific deleted messages in Eudora

If you have a large number of messages in the Message Pane, there are two ways to find the message you are looking for:

Searching the Subject line

1.  Select the first message in the Message Pane.
Select the button labeled Search in the toolbar (or press Ctrl-F) to search the Subject line.

Type a word or phrase in the field labeled Find what. Select the button labeled Find Next to locate the first subject
matching your terms.

4. Press the F3 key again to locate the next subject matching your terms. Repeat F3 until you find the right message.

Sorting the message headers
Select any column heading in the Message Pane to sort the message list by that column. For example, if you need to find a
message from iolo technologies:
1. Select the button labeled From at the top of that column. A small triangle appears in that column header. If the triangle
points up, messages appear in alphabetical order. Select the column heading again to reverse the sort order.
2. Scroll down the list to find the message from iolo technologies. Select the message to recover.

See Copying Message Text to the Clipboard.
Also see Switching between Search and Recover Tools.
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Using Email Recovery: Netscape/Mozilla recovery

Netscape/Mozilla Recovery Help Topics
q Recovering Netscape/Mozilla mail
Selecting a mailbox
Resurrecting a message
Saving a message as a file

g Changing Netscape mail profiles
Defining mail profiles

Locating mail profiles

g Locating a Netscape/Mozilla message
Sorting Subject headers

Searching Subject lines

q Copying message text to the clipboard
Selecting and copying message text

Pasting text in another document

Tips for successful email recovery
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Using Email Recovery: Recovering Netscape/Mozilla mail
Search and Recover can recover deleted email in Netscape or Mozilla 4.0, and supports multiple user profiles.

To recover Netscape or Mozilla mail:

1.

Select the button labeled Recover Lost Email in the Search and Recover main screen.
Select the button labeled Netscape Email in the Email Recovery Options screen.

Search and Recover locates the root mail folder of the default profile and displays its contents in the Folder Pane on
the left side of the Recover Deleted Mail screen. If the message you are looking for is stored in another profile, select
the button labeled Change Mail Profile in the toolbar to locate and open other profiles.

Select the mailbox you want to search (Inbox is a good place to start). Search and Recover shows messages deleted
from this folder in the right pane.

If you want to manage the Read status of recovered messages, select the button labeled Options, and then in the
drop-down menu that appears, select the item labeled Mark Recovered Items as Read to mark the recovered
messages as read, select the item labeled Mark Recovered Items as Unread to mark the recovered messages as
unread, or select the item labeled Keep Original Read State to restore the Read status of the messages.

Use one of the following two methods to recover your messages:

g Select the button labeled Resurrect at the top of the Recover Deleted Netscape Messages screen to recover
the selected messages to the Netscape folder in which they were found.

gq Select the button labeled Save at the top of the Recover Deleted Eudora Messages screen to recover the
selected messages and store them as files outside of Eudora. Use the Browse dialog that appears to identify
the folder in which you want to place the message files. Message files open in the email application set as the
default on your system.

See Copying Message Text to the Clipboard.

Also see Switching between Search and Recover Tools.
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Using Email Recovery: Searching for specific deleted messages in Netscape or
Mozilla

If you have a large number of messages in the Message Pane, there are two ways to find the message you are looking for:

Searching the Subject line
Select the first message in the Message Pane.
Select the button labeled Search in the toolbar (or press Ctrl-F) to search the Subject line.

Type a word or phrase in the field labeled Find what. Select the button labeled Down. Select the button labeled Find
Next to locate the first subject matching your terms.

4. If necessary, press the F3 key to locate the next subject matching your terms. Repeat F3 until you find the right
message.

Sorting the message headers

Select any column heading in the Message Pane to sort the message list by that column. For example, if you need to find a
message from iolo technologies:

1.  Select the button labeled From at the top of that column. A small triangle appears in that column header. If the triangle
points up, messages appear in alphabetical order. Select the column heading again to reverse the order.

2. Scroll down the list to find the message from iolo technologies. Select the message to recover.

See Copying Message Text to the Clipboard.

Also see Switching between Search and Recover Tools.
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Security tools

Security Tools Help Topics

g Delete files securely with File Terminator
Enabling File Terminator
Terminating a file

g Clean and sanitize deleted files
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Using File Terminator: Deleting files securely

Files that are deleted in Windows, either by a user or by an application or system process, are not removed from the hard drive.
Instead, the operating system simply ‘forgets’ that the data is there. Although deleted data may eventually be overwritten as the
system re-uses that portion of the hard drive for new data, you cannot be sure at any time that your deleted data has actually
been overwritten or physically removed from your drive.

If you have sensitive data that you need to erase permanently, use Search and Recover’s File Terminator tool. File Terminator
lets you repeatedly overwrite deleted data so that no data recovery tool can retrieve it.

You can also use the Clean and Sanitize option in the Advanced Deleted File Search screen to permanently delete files.

Enabling File Terminator
1.  Select the button labeled Security Tools in the Search and Recover main screen.
2. Make sure the button labeled Enable File Terminator is selected.

Specify the number of times you want File Terminator to overwrite deleted data. Type in the number, or use the arrow
buttons to make your selection. (The maximum number of overwrites is 100.) In most situations, five overwrites is
sufficient.

4. Select the button labeled Back to main options to enable File Terminator and to return to the main screen.

Terminating a file

1. In Windows Explorer (or any other file-management tool), right-click on the files or folders you want to terminate
(permanently erase).

2. Select the item labeled Terminate from the context menu that appears.

The files or folders are permanently deleted.

Return to Clean and Sanitize
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Specific types of files

Both the File Rescue Wizard and Advanced Deleted File Search let you find files based on their file extension. (file type). When
you select the relevant button, Search and Recover finds the associated file types.

Common groups
g Documents: Microsoft Word (DOC, DOT, DOCHTML, DOTHTML), WordPerfect (WP, WPD), and Write (WRI)
g Pictures: GIF, BMP, JPG, JPEG, TIF, TIFF, PhotoShop PSD, WMF, EMF, Al, Encapsulated PostScript (EPS), and Icon
(ICO)
Programs: EXE, BAT, COM and PIF
Web pages and related items: HTM, HTML, JavaScript (JS), ASF, ColdFusion (CFM), PHP and CGI

Multimedia: Movies (MOV, AVI, MPEG, MPG, MP2), Music files (MP3, WAV), Windows Media (ASF, WMA, WMV,
WM), and RealAudio (RAM)

Word: DOC, DOT, DOCHTML, and DOTHTML
Excel: WBK, WIZ, XLS, and XLT
PowerPoint: PPA, PPS, PPT, PPTHTML, PPV, and PWZ

Individual Types

Select the button labeled Individual Types to generate a list of all registered file types. A short description of each extension is
included. Select any button to include that file type in your search.

Advanced Deleted File Search

Setting up Search Criteria
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Connected devices

Search and Recover works with nearly every type of storage device that you can connect to your computer (as long as the
device is assigned a drive letter in Windows). These devices include:

q lomega Zip drives (either IDE or USB) and other removable hard drives (for example, SCSI, FireWire, IDE, or USB)
q Digital Camera storage: SmartMedia, Memory Sticks, USB Flash drives
q Portable MP3 players

If the File Rescue Wizard or Advanced Deleted File Search screen does not display your removable device, follow these steps:

1. Make sure your device cable is securely connected to the correct port (for example, USB, parallel or serial) in the back
of your computer.

2. Select the button labeled Rescan Drive List in the File Rescue Wizard screen or the Search Options dialog available
from the Advanced Deleted File Search.

If your device has been assigned a drive letter on your computer, it will now appear in the drive list.

See Recovering Lost Files.

Return to Advanced Deleted File Search
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Using the Advanced Deleted File Search: Security Functions

Use the tab labeled Security Functions in the General Options dialog to turn File Terminator on (or off) and to set the number of
passes used to permanently erase files, and to determine how the Clean and Sanitize function operates.

Select the button labeled Show File Terminator Context Menu to allow File Terminator to appear in Windows context menus.
When you select File Terminator, the highlighted files are permanently removed from the hard drive.

Enter the desired number of overwrites for terminated files in the field labeled Overwrites.

See Advanced Deleted File Search Options.

Return to Advanced Deleted File Search
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Using Email Recovery: Changing the Netscape Mail profile

Netscape mail profiles allow different users to share Netscape Mail on a computer, while maintaining their own mailboxes.

Use the Change Netscape Mail Profile dialog to select from multiple Netscape/Mozilla profiles (that is, mailboxes) in order to
recover the desired email messages.

1. The top pane of this screen names profiles that were found on your computer. Highlight the profile that contains the
mailbox that you want to search for deleted messages, and then select the button labeled Open Selected.

2. If Search and Recover did not locate the mailbox from which you want to recover messages, you can locate additional
profiles in the bottom pane of this screen. Select the button labeled Browse to navigate to the folder containing the
profile.

3. Once you have selected the needed profile, select the button labeled OK to add that profile to the bottom pane.
Select the button labeled Open Selected to begin your search.

Return to Netscape/Mozilla Recovery
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Obtaining technical support

Search and Recover provides several ways to get help and solve problems. Select the button labeled Options and
Documentation from the Search and Recover main screen to get more help.

Read Online Documentation: Select this button to open this help file.

Web Based Support Options: Select this button to visit the iolo Technical Support Web site to get answers to your
questions.

q Check for Updates: Select this button to download the latest version of Search and Recover over the Internet using
WebUpdate.
q About Search and Recover: Select this button to identify your current version of Search and Recover.

You can also contact us directly:

Web based support: http://www.iolo.com/support

Web based sales: http://www.iolo.com/order

Toll-Free Sales Phone: 877-239-4656

Customer Service Phone: 626-793-3993

Return to Updating Search and Recover with WebUpdate
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WebUpdate options

Automatically Check for Updates Every X Days

Use this button to manage two functions of the WebUpdate tool:

g To toggle WebUpdate’s automatic checking and reminder system, deselect the button labeled Automatically check
for updates every.... When this button is deselected, WebUpdate no longer checks automatically for product
updates at startup.

g To adjust the number of days WebUpdate waits before checking for new updates, enter a new value in the field labeled
Automatically check for updates every.... The minimum number of days that WebUpdate will wait is one day, and
the maximum it will wait is 360 days.

Connect using a proxy server

If you or your company uses a proxy server to access the Internet you will need to specify this before using WebUpdate. Use the
following steps to set up WebUpdate for use via a proxy server:

Select the button labeled Options from the WebUpdate wizard.

Select the button labeled Connect using a Proxy Server.

In the field labeled Proxy Server, specify the server name or address.

In the field labeled Proxy username, specify your username for use with the proxy server.
In the field labeled Password, specify your password for the proxy server.

Select the button labeled OK.
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Registering Search and Recover

To get technical support and other privileges, you must register Search and Recover. To register, execute WebUpdate:
1. When you select the button labeled Next in the first WebUpdate screen, the Register with iolo screen appears. Select
the button labeled Register Now to start the process.
Your web browser opens. Use the drop-down menu to select Search and Recover.
Select the button labeled Next.

You are asked for your serial number, the version of Windows that you are using, and some personal information. Only
the items marked with asterisks are required.

5. Select the button labeled Register to finish.

Return to Updating Search and Recover with WebUpdate
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Using Emergency Disk Images: Making a new disk image

Disk Image Wizard Help Topics

g Telling Emergency Disk Image what type of image to make
Cloning a drive or partition
Making an empty image

g Defining where and how to store your image
Naming and describing the image
Telling Emergency Disk Image where to store the image
Mounting the image
Creating a sparse image (NTFS only)

g Creating your image

Return to Emergency Disk Images
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Using Emergency Disk Images: Disk image type

Select the button labeled New Image in the Working With Disk Images screen to launch the Disk Image Wizard. The first
screen of the Wizard lets you specify the type of image you want to create.

g Create a clone of an existing drive on your system

Select this button if you want a byte-for-byte clone of an existing drive or partition. Select the drive you want to copy from
the list. You can make an image of only one drive or partition at a time. If a device you want to image does not appear,
make sure it is connected properly and then select the button labeled Rescan drive list.

g Create a new empty disk image of a fixed size

Select this button to create an empty virtual drive that you can format, mount, and use to store files. By default, you create a
10 MByte volume. Type your preferred size in the field, or use the Up and Down arrows. If the button labeled Megabytes
is selected, you can create an image up to 10,000 MBytes (assuming there is that much space available on the target
drive). If the button labeled Gigabytes is selected, the maximum size is 1,000 GBytes (assuming your target drive can hold
an image file of that size).

When you have made your selection, select the button labeled Next.

Return to Making a New Disk Image

Return to Emergency Disk Images
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Using Emergency Disk Images: Disk image options

The second Disk Image Wizard screen lets you name and describe your image, specify where it is created, and assign a drive
letter.

q

Image Name: Emergency Disk Image creates a single file with an extension. of IMG. Select a name for the image file. Use
the default, or choose a name of your own.

Description: Type a description of the image, if one is required. For example, if you are creating an empty image that will
hold a copy of your Windows folder, you may decide to add a description such as, "Storage Space for C:\WinNT and its
subfolders as of <date>."

Save as: Select the location for the new disk image. By default, Disk Image stores the image in a Disk Images subfolder in
the My Documents folder. You can change this by typing in a different path, or by selecting the folder icon to browse to a
location. You can select the button labeled New Folder to create a new folder.

You can store an image on a removable drive or CD-R/CD-RW. The image size must not be greater than the capacity of the
target medium.

If you are cloning data from a volume formatted in NTFS, and the target medium is formatted using FAT16 or FAT32, the
creation process is slower. This is especially true if the image is larger than one gigabyte, as Emergency Disk Image must
create the image in multiple gigabyte-sized chunks.

Mount as drive: By default, Emergency Disk Image will mount this image and assign it the first available drive letter. Use
the drop-down menu to select a different drive letter for the mounted image. Deselect this button if you do not want to mount
the image immediately upon creation. You can mount the image later using the main Working With Disk Images screen.

Create as a sparse image file: When you create an empty image on an NTFS partition, select this button to give the image
file the ability to maximize usage of the available space. This sparse image will take up less actual space on the drive than
the space you allocate to it.

Select the button labeled Create once you have set your options.

Return to Making a New Disk Image
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Using Emergency Disk Images: Creating an image

When you select the button labeled Finish in the Disk Image Options screen, the Disk Image Wizard creates the new image
file. You see a progress bar as the image creation takes place. When the image is created, the Disk Image Wizard reports
information about the disk image.

Return to Making a New Disk Image
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Purchasing Search and Recover

We hope that Search and Recover proves itself to be a valuable addition to your set of system tools. We have put together some
information to make it easy for you to purchase a licensed copy of our software.

{button Click here to purchase over the Internet using a credit card,EF (" http://www.iolo.com/purchase.cfm',”",5,")}

What do | get if | purchase?

Free, unlimited access to telephone, email, web and fax-based technical support.

Free WebUpdates including minor releases (to v1.1, 1.2, etc) and all service releases and fixes.
Notifications about, and generous discounts on, all new major version upgrades (to v2.0, 3.0, etc.)

o 0o o o

Great software created by people dedicated to providing quality products to people like you!

How much does it cost?
g Single computer: $39.95

g Site licenses and multiple computers: Please contact iolo technologies at 1-626-793-3993 or
http://www.iolo.com/contactus.cfm.

How do | order?

Instant and secure web-based ordering using a credit card

{button Click here to order online now,EF(http://www.iolo.com/order’,™,5,™")}

Toll-free by telephone
From the US: 1-877-239-I0LO (7:00 AM - 6:00 PM, Mon-Fri, Pacific Time)

Non-US orders: 1-626-793-3993

By mail or fax

You may fax or mail your order to us. Your product is delivered when payment is received.
Fax: 1-626-793-1554
Mailing address:

iolo technologies, LLC
145 North Sierra Madre Blvd., Suite 1
Pasadena, CA 91107

Can | use a purchase order?

Yes, we accept corporate purchase orders. We may request credit references prior to final approval and delivery. Our terms are
net payment within 30 days of delivery. Purchase orders are encouraged for larger quantity orders.

For amounts under $100.00 there will be an additional $20.00 processing fee added to the total amount due. For amounts less
than $100.00, credit card payments are preferred (eliminating the processing fee). For more information, please contact the iolo
technologies sales department at 1-626-793-3993, or visit our website at _http://www.iolo.com/contactus.cfm .

Can | pay by bank transfer?

Yes, bank transfers are accepted for amounts over $100. Please contact iolo technologies at 1-626-793-3993 or
http://www.iolo.com/contactus.cfm for our incoming payment bank details.

I'd like to resell this product



We are always looking for interested resellers for our products. If you are interested in reselling Search and Recover or any other
iolo technologies product, please contact us at 1-626-793-3993 or http://www.iolo.com/contactus.cfm.

Return to Search and Recover Help Topics




Using the Advanced Deleted File Search: Print Preview

Use Print Preview to see how your raw content or image will look when you print it. You can use the Print Preview screen to
resize your file or change your printer options. You can also print directly from the Print Preview screen.

NOTE: All of these options are also available in the main Advanced Deleted File Search screen.

File menu

g Print: Print the contents or image. When printing an image, you have two choices:
1. Print the image as is (Keeping original size)
2. Scale the image to fit the width of your paper

g Print Setup: Open the Windows Print Setup dialog in order to change the default print settings. Select the printer you want
to use, or change any print-related properties.

g Exit: Return to the Advanced Deleted File Search screen.

Scale menu

By default, Advanced Deleted File Search prints file contents or images at full size. Select the Scale menu to make the print
smaller (less than 100%) or larger (more than 100%).

When viewing images, you can also select the button labeled Stretch image to fit window. This makes the image as wide as
the Print Preview window. If you resize the window, the image also resizes.

Return to Printing Recovered Files

Return to Advanced Deleted File Search
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Using the Advanced Deleted File Search: Finding Text in Files

Finding Text in Files is a powerful search option that lets you search through deleted files to find specific strings of text. Once
you have found the desired text, you can then choose to recover the text.

1.

Once you have completed a standard search, select the Search menu and then select the item labeled Find Text in
Contents of Found Files (or just press Ctrl-F) to open the Text Search Pane on the right side of the Advanced
Deleted File Search screen.

Type the text you want to locate into the field labeled Text to find. Select the button labeled Case Sensitive at the
bottom of the pane if you want Advanced Deleted File Search to consider capitalization when searching.

Select the files you wish to search for the text:

g Select the button labeled Search contents of all files to locate text in all of the files that match your original
search. This is the default.

g Select the button labeled Search contents of selected file if you have already found the file containing the
text.

Choose where to begin your search:
g Select the button labeled Start from beginning to search the entire file for the desired text.

g Select the button labeled Start from current position if you have started looking through the Text View, and
know that the desired text is below your current location.

g Select the button labeled Start from cluster if the file you are searching takes up more than one cluster on
the drive, and you wish to start your search in a different cluster.

Select the button labeled Search to begin the text search. Advanced Deleted File Search locates the first instance of
the text string and highlights it. Select the button labeled Find Next to locate the next instance. Repeat until you find
the desired text.

You can also use the Find Text function with Advanced Deleted File Search’s Copy function, recovers specific words, sentences,
phrases and paragraphs from a deleted file without having to recover the entire file. To do this, continue with the following steps:

6.

7.

When you find the text you want to copy, select the Edit menu and then select the item labeled Copy Selected Raw
Text to Clipboard to put the selection on the clipboard.

Open a word processor or text editor and paste the text into a document.

Return to Advanced Deleted File Search
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Using the Advanced Deleted File Search: Setting up search criteria

To begin using Advanced Deleted File Search to search for deleted files and folders:

Open Search and Recover.

Select the button labeled Advanced Deleted File Search in the Search and Recover main screen.

3. Select the button labeled Search in the toolbar, or select the Search menu and then select the item labeled New

search.

4. The Search Options screen appears. Use each of the following tabs to specify your criteria:

q

o0 0 0 0 o o

Locations
Condition
Size
Attributes
Dates
Eiles

Exclusions

5. If you wish to save this set of search criteria for future use, select the tab labeled Search Profile.

Now you are ready to execute the search.

Return to Advanced Deleted File Search
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Using the Advanced Deleted File Search: Executing the search
When you have finished setting your search criteria, select the button labeled Search at the bottom of the Search Options dialog
to locate the deleted files that match your specifications. A progress bar dialog shows you how the search is proceeding.

Stopping a search

You can stop a search at any time by selecting the button labeled Cancel in the progress bar dialog. Advanced Deleted File
Search stops searching the drive. Matching files identified to this point are not displayed.

When the search is complete, files and folders matching your criteria appear in the Advanced Deleted File Search screen.

Return to Advanced Deleted File Search
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Using the Advanced Deleted File Search: Restoring folders to another location

Select the Recover menu in the Advanced Deleted File Search screen in order to restore the contents of deleted folders.

Select a folder in the Folder Pane on the left side of the Advanced Deleted File Search screen.

2. Select the Recover menu, and then select the item labeled All Items in Selected Folder. If the option is not available,
go up one level in the folder tree and then try again.

3. The Folder Restore dialog appears. This dialog determines how Advanced Deleted File Search handles restored
folders. Options include:

g Destination folder: Type in the destination folder’s path, or select the button labeled Browse in order to
identify the location for the restored folder. We highly recommend restoring the folder to a drive or partition
different from the one containing the original file which is being recovered. Otherwise, you risk overwriting
some of the data you are trying to restore.

g Undelete all items located in subfolders: Select this button if you want to recover files in subfolders. If you
want the folder structure to remain intact, select the button labeled Reconstruct folder structures. To
recover files to the main destination folder without restoring subdirectory structures, select the button labeled
Place all deleted files in destination folder.

g Create Log: Select this button in order to generate a log of the events and actions taken during the
recovery. If the recovery is not completely successful, the log will provide useful information about the
recovery.

? IMPORTANT:
If you are recovering data from the partition on which Search and Recover is installed, the log file may
overwrite the data you want to recover.

More information here

g Options: Select this button to open the tab labeled Batch Recovery tab. This tab lets you specify how
duplicate files are handled in the destination folder.

4. Select the button labeled OK to confirm your selections and recover the items. Select the button labeled Exit to cancel
the request to recover the folder.

Return to Advanced Deleted File Search

Return to Search and Recover Help Topics




License agreement
SEARCH AND RECOVER LICENSE AGREEMENT

IOLO TECHNOLOGIES, LLC DISCLAIMS ALL WARRANTIES, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, WITH
RESPECT TO THE SOFTWARE OR DOCUMENTATION. SHOULD THE PROGRAM PROVE DEFECTIVE, THE
PURCHASER ASSUMES THE RISK OF PAYING THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR, OR
CORRECTION AND ANY INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES. IN NO EVENT WILL IOLO
TECHNOLOGIES BE LIABLE FOR ANY DAMAGES WHATSOEVER (INCLUDING WITHOUT LIMITATION TO DAMAGES FOR
LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION AND THE LIKE) ARISING
OUT OF THE USE OR THE INABILITY TO USE THIS PRODUCT EVEN IF IOLO TECHNOLOGIES HAS BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES. IN PARTICULAR, IOLO TECHNOLOGIES SHALL HAVE NO LIABILITY FOR ANY
DATA STORED OR PROCESSED WITH THIS SOFTWARE, INCLUDING THE COSTS OF RECOVERING SUCH DATA. ASA
RESULT, THIS SOFTWARE AND DOCUMENTATION ARE LICENSED °‘AS IS’ AND YOU, THE LICENSEE, ARE ASSUMING
THE ENTIRE RISKAS TO ITS QUALITY AND PERFORMANCE.

Information in this document is subject to change without notice and does not represent a commitment on the part of IOLO
TECHNOLOGIES. The software described in this document is furnished under this license agreement.

USE OF THIS PRODUCT FOR ANY PERIOD OF TIME CONSTITUTES YOUR ACCEPTANCE OF THIS AGREEMENT AND
SUBJECTS YOU TO ITS CONTENTS.

US GOVERNMENT RESTRICTED RIGHTS

Use, duplication, or disclosure by the Government is subject to restrictions as set forth in subdivision (b)(3)(ii) of the Rights in
Technical Data and Computer Software clause at 25 2.227-7013. Contractor / manufacturer is

IOLO TECHNOLOGIES, LLC
145 North Sierra Madre Blvd.
Suite 1

Pasadena, CA 91107

Copyright and Trademark Acknowledgments

Copyright 2003, iolo technologies, LLC.

The Search and Recover software, documentation, logos and graphics, and the iolo technologies logo are Registered
Trademarks of iolo technologies, LLC.

Windows, Windows 95, Windows 98, Windows NT, Windows Me, Windows 2000, and Windows XP are trademarks of Microsoft
Corporation. All other trademarks are property of their respective owners.
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Search and Recover

It happens to all of us. An important document gets swept away in a frenzy of file cleaning. An email message from an important
client disappears. But there Is no need to panic.

iolo Search and Recover is an arsenal of powerful tools designed to let you quickly and easily find and recover deleted,
destroyed, and damaged data on your PC. You can use it to find items such as folders, songs, pictures, videos, applications,
critical system components, web pages, and email messages in Microsoft Outlook and Outlook Express, Netscape, and Eudora.

Search and Recover works with any hard disk drive or floppy disk drive, and with any drive format or size of disk. Search and
Recover even allows recovery of lost or deleted pictures, songs, and other files from digital cameras, MP3 players, USB flash
drives, and other devices with various types of removable media.

Search and Recover includes two other data protection tools:

q File Terminator securely deletes sensitive material so it cannot be recovered.

q Emergency Disk Image creates virtual, portable partitions to create cloned images of your hard drive, to help you
manage your backups, to store secure extra copies of sensitive files, and much more.

Tell me more about Search and Recover

System Requirements
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Tips for successful data recovery

There are two tips to remember when using any data recovery product.

1. Recover deleted data as soon as you can. Deleted data is more likely to be recovered intact if you try to recover it
as soon as you find out that it is gone. When you delete a file, the space on the disk is marked as available for new
data. The more new data is written to the disk (for example, when documents are created or added, web pages visited
and stored in the cache, programs installed or started, or files and folders moved around), the harder it becomes to
recover fully intact, deleted data. Even restarting your computer can overwrite data.

2. Always recover data to a different drive, partition or device. When you delete a file, the space on the disk is
marked as available for new data. Restoring a portion of deleted data to the same partition that contains the deleted
data creates a serious risk that another part of the same data will be overwritten, defeating the purpose of the recovery
effort. Once files has been recovered to another location, and all recovery options are complete, you can safely move
restored files back to their original location.

Return to Search and Recover Help Topics




Using the File Rescue Wizard

File Rescue Wizard Help Topics

g Introduction to File Rescue Wizard

g Telling File Rescue Wizard what to search for
Searching for specific file types

Setting up a custom search

g Specifying places to search for deleted data
Drives and partitions located on your system

Devices located on your system
Searching for devices not located on your system

g Recovering found items
Recovery options

Dragging and dropping

Return to Recovering Lost Files
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Using the File Rescue Wizard: Things to Search For

When you open the File Rescue Wizard, you must first choose the types of files you want to find. The first screen of the Wizard,
labeled Things to Search For, lets you limit the types of files you will include in your search results.

Select the button labeled All Files in order to see everything the wizard can find.

Select the button labeled Specific types of files to narrow the search. The Wizard uses the file’s extension. to
determine the file type. Select the appropriate buttons for the kinds of files you want to find. Select the button labeled
Other to add a search based on the file name. The options in File Rescue Wizard are:

o

o

Documents: Microsoft Word (DOC, DOT, DOCHTML, DOTHTML), WordPerfect (WP, WPD), and Write (WRI)

Pictures and Images: GIF, BMP, JPG, JPEG, TIF, TIFF, PhotoShop PSD, WMF, EMF, Al, Encapsulated
PostScript (EPS), and Icon (ICO)

Music, Sounds and Video: Movies (MOV, AVI, MPEG, MPG, MP2), Music files (MP3, WAV), Windows Media
(ASF, WMA, WMV, WM), and RealAudio (RAM)

Programs and Applications: EXE, BAT, COM and PIF
Web pages and related items: HTM, HTML, JavaScript (JS), ASF, ColdFusion (CFM), PHP and CGl

TIP: Use wildcards when doing a file name search. When a file is deleted on Windows 95, 98 and ME systems, the first
letter of the file name disappears when a file is deleted. Wildcarding the first character of the filename ensures that you
will find matching files regardless of a missing first character.

g When you have selected the types of files you want to find, select the button labeled Next to identify where to look for

files.

Return to File Rescue Wizard

Return to Recovering Lost Files
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Using the File Rescue Wizard: Places to Look

Use the File Rescue Wizard’s second screen, labeled Places to Look, to identify folders where you wish to search.

1. By default, the File Rescue Wizard searches your hard drives. Deselect any button if you do not want to search the
associated drive. Any connected device also appears in this list.

2. If the device you want to search does not appear in this list, select the button labeled Rescan drive list to find it. If the
device was not connected properly, you may have to restart your computer before File Rescue Wizard can see the
device.

* IMPORTANT: |If you are trying to recover data from your hard drive and a connected device at the same time, restarting your
computer may result in some data being overwritten.

3. Select the button labeled Scan to begin searching for your specified files. Select the button labeled Back to change
your Things to Search For options.

4. File Rescue Wizard searches the selected drives to locate the files you have specified, and to display the results. If
you need to stop the scan at any point, select the button labeled Cancel. The scan stops, and you return to the Search
and Recover main screen.

5.  When the scan is complete, you are ready to recover your lost files.

Return to File Rescue Wizard

Return to Recovering Lost Files
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Using the File Rescue Wizard: Recovering files

When the File Rescue Wizard completes its scan, a list of files matching your search criteria appears. You can sort the search
results by name, location, size, type or date modified by selecting the column header of the appropriate column.

There are three ways to recover files using the File Rescue Wizard’s Recovery screen.

Recovering files with the button labeled Recover

1.

Select the files you want to restore. Highlight a file name to select that file for recovery. To select multiple files, hold
down the Ctrl key while you select each file name. To select all files in the list, select one file in the list and then press
Ctrl-A.

When you have made your selections, select the button labeled Recover selected items.

Browse to the folder in which you want to place the recovered file. To create a new folder, select the parent folder, and
select the button labeled New Folder. Type the name of the folder in the field. When you have selected the folder,
select the button labeled OK.

If there are other files you want to recover to a different location, repeat the above steps.

When you have finished recovering files, select the button labeled Finish in order to return to the Search and Recover
main screen.

Recovering files using drag and drop

1.
2.

Open Windows Explorer.

Select the files you want to restore. Highlight a file name to select that file for recovery. To select multiple files, hold
down the Ctrl key while you select each file name. To select all files in the list, select one file in the list and then press
Ctrl-A.

Drag and drop your selection into a folder on another drive or device in Windows Explorer.

When you have finished recovering files, select the button labeled Finish in order to return to the Search and Recover
main screen.

Recovering files through the context menu

1.

Select the files you want to restore. Highlight a file name to select that file for recovery. To select multiple files, hold
down the Ctrl key while you highlight each file name. To select all files in the list, select one file in the list and then
press Ctrl-A.

Right-click on any selected file name. A context menu appears. Select the item labeled Recover Selected to choose
the folder to which you want to recover the files.

Browse to the folder in which you want to put the recovered files. To create a new folder, select the parent folder, and
select the button labeled New Folder. Type the name of the folder in the field. When you have selected the folder,
select the button labeled OK.

When you have finished recovering files, select the button labeled Finish in order to return to the Search and Recover
main screen.

Return to File Rescue Wizard
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Introduction to data recovery

Data is stored on a drive in clusters. When you delete a file, the file is not physically deleted from your hard drive. Instead, your
computer ‘forgets’ that the file exists. Even after you empty the Recycle Bin, sections of data remain until the associated clusters
are overwritten with new data. You can read — and recover — much of the data that has been lost or deleted on your hard drive,
floppy disk or other medium.

When you format a drive or partition, the formatting tool creates the structure of clusters on the drive or partition, and generates a
partition table that stores information about the physical location of each file you place on that drive or partition. When you
create, save or download a file, the operating system stores the new information on a cluster and fills in the partition table so that
it knows where to look when opening or otherwise acting on the file.

When you delete a file from the Recycle Bin, the clusters that the file occupied are marked as available in the partition table. The
next time a file is added to the drive or partition, or a file increases in size (for example, when a new item enters your Web
browser cache, or you finish working on a draft document), the data is stored in one of these available clusters, destroying the
old data that was left in that cluster.

The size of each individual cluster depends on your operating system and the size of your partitions. Regardless of cluster size,
large files will take up a large number of clusters. Smaller files may only occupy one or two clusters. Once part of a file occupies
a cluster, no other file can share that cluster.

* IMPORTANT: To maximize the chances of successful recovery:
g Always use Search and Recover as soon as you know you need to recover a file.
g Always recover files to a different drive or partition, if one is available.

More information here

Return to Recovering Lost Files
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Advanced Deleted File Search

Advanced Deleted File Search Help Topics

g Introduction to Advanced Deleted File Search

Searching for Deleted Files

q Setting up your search criteria
Where to search

What kinds of files to search
Searching on special file characteristics

g Saving your search criteria for future use
Saving a Search Profile
Loading a saved Search Profile
Deleting a saved Search Profile

q Executing the search

Working with Found Files

g Understanding the Folder Pane
Choosing how to display folders in your search results

g Understanding the File Pane
Viewing the list of recoverable files in the File Pane
Viewing the contents of recoverable files in the Viewer Pane.

g Refining your search results
Starting a new system search
Changing your search filter
Searching your results for specific folder and file names
Finding text in the content of found files

Recovering Deleted Files

g Restoring deleted files to another location
Saving data to a new file

Dragging and dropping files to a new location
Using the context menu to recover files

g Restoring folders to another location
Setting a location for the restored folder
Handling duplicate files
Logging the process
Setting options

g Finding and copying text to another file
Searching for text inside recoverable files



Searching in raw content

q Permanently Remove Deleted Files
Cleaning and sanitizing deleted files so they cannot be recovered

See Advanced Deleted File Search menus.

Return to Recovering Lost Files

Return to Search and Recover Help Topics




Using the Advanced Deleted File Search: Understanding the Folder Pane

The Advanced Deleted File Search screen contains three panes. The Folder Pane appears in the left portion of the screen.

After you execute a search, a list of folders appears in the Folder Pane. The icon that appears beside each folder name tells you
the status of that folder:

This drive or partition contains deleted files or folders.
This drive or partition does not contain any deleted files or folders.
This folder was not deleted but does contain deleted files or folders.

The folder icon changes when it is opened.
This folder has no deleted items within it.

The folder icon changes when it is opened.

SVUHE]) B

This folder has been deleted, but has no deleted files in it. It only
appears if the folder was searched as an added location, or if you chose to
display all folders.

£ The folder icon changes when it is opened.

This folder has been deleted, but also contains deleted subfolders.

The folder icon changes when it is opened.

Select a folder to see any deleted contents appear in the File Pane in the upper right portion of the screen.
Select the + sign next to a folder (or select the folder and press the Enter key) to see any subfolders appear in the Folder Pane.

If you cannot see everything in the Folder Pane, resize the pane by clicking and dragging the borders dividing the Folder Pane
from the File and Viewer Panes.

See Understanding the Advanced Deleted File Search Panes.

Also see Advanced Deleted File Search menus.

Return to Advanced Deleted File Search
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Using the Advanced Deleted File Search: Understanding the File Pane

The Advanced Deleted File Search screen contains three panes. The File Pane appears in the upper portion of the screen.

The File Pane shows a list of files contained in the folders you have selected in the Folder Pane.

To sort the contents of the File Pane based on a column’s contents, select the column’s heading:

Name
The file name. In addition to the full name (or full name minus the first character), the program icon associated with that
file appears, as it would in Windows Explorer. (The icon appears only if the file type can be identified.)

Size
Displayed in bytes, kilobytes, megabytes, or gigabytes, depending on the size of the file.

Type
Windows file type, based on the file extension.

Condition
The probability of successful recovery of the file.

Modified date
The date when the file was last changed or saved.

Created date
The date when the file first appeared on the system. This corresponds to the time when it was downloaded, installed or
otherwise saved for the first time.

Accessed date

The date when the file was last opened or "looked at" by you or by application on your computer. This value may
represent the last time the file was opened for editing, scanned by another application (such as an antivirus program),
or checked by a utility like Windows ScanDisk.

Attributes

Afile’s attributes denote specific properties of the file such as whether it is "read-only" (cannot be changed), or falls
into a specific Windows category of files such as "system", "hidden", or "archive". These properties (flags) are part of a
file, added by Windows or the application associated with it.

When you select a file in the File Pane, the contents of the file appears in the Viewer Pane in the lower right portion of the
screen.

If you cannot see everything in the File Pane, resize the pane by clicking and dragging the borders dividing the File Pane from
the Folder and Viewer Panes.

See Understanding the Advanced Deleted File Search Panes.

Also see Advanced Deleted File Search menus.

Return to Advanced Deleted File Search
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Using the Advanced Deleted File Search: Understanding the Viewer Pane

The Advanced Deleted File Search screen contains three panes. The Viewer Pane appears in the bottom portion of the screen.
When you select a file in the File Pane, the contents of the file appears in the Viewer Pane.

Four tabs at the bottom of the Viewer Pane let you select the type of view appropriate to your data:

o0 0 o0 o
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If you cannot see everything in the Viewer Pane, resize the pane by clicking and dragging the borders dividing the Viewer Pane
from the File and Folder Panes.

See Understanding the Advanced Deleted File Search Panes.
Also see Advanced Deleted File Search menus.

Return to Advanced Deleted File Search
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Using Email Recovery: Copying message text to the clipboard

To copy text from any deleted message (except a message in Outlook) to the clipboard in order to paste it into another
document:

Select the message you want to work with in the Message Pane of the Email Recovery screen.

2. Select the text or other content you want to copy. To select the whole message text, select the Edit menu and then
select the item labeled Select all displayed text.

3. Select the Edit menu and then select the item labeled Copy selected text to clipboard.
Paste the text into the desired document.
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Emergency Disk Images
Emergency Disk Images Help Topics
g Introduction to emergency disk images

g Making a new disk image

g Adding and removing an existing disk image from the list
Installing an existing image
Removing an existing image

g Mounting and unmounting a disk image
Making an image visible to your system

g Assigning a new drive letter to an image

g Moving an image to another location

g Editing image information
Changing an image’s name

Changing an image’s description

g Deleting an image
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Introduction to Emergency Disk Images

The Emergency Disk Image tool gives you a powerful way to protect critical files, manage partitions and safely recover deleted
files.

Emergency disk images let you:

Create a byte-for-byte clone of an existing drive or partition — including all deleted files — for storage elsewhere.

Create a virtual drive that can be formatted, mounted, compressed and stored, and can contain folders or files that appear
as they would on your hard drive.

You may use the Emergency Disk Image tool for any number of purposes. For example:

g Store your most sensitive, mission-critical data in an unmounted image, accessible only through Search and Recover.

g Store the entire contents of a CDROM as an image for easy sharing, archiving or portability (for example, if you wish to
mount the CDROM on a laptop without having to use your laptop’s CDROM drive).

Make speedy and frequent backups to a network volume, removable drive, or to writable CDs or DVDs.

Keep snapshot copies of your drives for backup purposes. This lets you restore files from your disk images, including any
files that were recoverable at the time.

g Create blank images for use with files that only need to be accessed periodically, such as collections of pictures, videos,
important personal documents, and the like.

g If you have accidentally deleted a critical file — for example, a Windows registry file — clone the C: drive (assuming you
have enough space available), mount the clone, then execute an Advanced Deleted File Search on the cloned drive to
restore the registry to C:.
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Using Emergency Disk Images: Installing an existing disk image

When you create a new disk image, the Disk Image Wizard adds the image to the list that appears when you open the Working
With Disk Images screen. You can remove the image from the list without deleting the image file from your hard drive. You can
also add a disk image file from your hard drive to the image list.

Restoring an uninstalled image

1.
2.
3.

Select the button labeled Install on the Working With Disk Images screen.
In the drop-down menu that appears, select the item labeled Install image not listed.

Use the dialog that appears to browse to the location of the desired image. The default location for all disk images is c:
\My Documents\Disk Images. Select the image file, and then select the button labeled OK to restore the image to the
list.

In the dialog that appears, make any required changes to the image name and description. To change the image
name, type the new name in the field labeled Disk Image Name. To change the image description, type in new
information in the field labeled Image Description.

If you want the image to mount as a CD or DVD, select the button labeled This Image is a CD or DVD.
Select the button labeled OK. The image now appears in the image list.

Removing an Image from the list

1.

Select an image from the Installed Disk Images list on the Working With Disk Images screen.
Select the button labeled Install on the Working With Disk Images screen.
In the drop-down menu that appears, select the item labeled Uninstall Selected Image.

The image no longer appear on the list. The image file remains on your hard drive.
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Using Emergency Disk Images: Mounting and unmounting a disk image

When a disk image is mounted on your system, it behaves exactly the same as any other partition on your system. You can copy
files to and from the image, install applications, create and delete data files, and perform any other file system task. You can
mount up to four images on your system at any one time.

* Note: If you are using an image to preserve or back up a drive or partition, store the image file on a different drive from the one
you are backing up. This ensures that a drive failure will not compromise your backups. In addition, leave the image unmounted to
ensure that it is not compromised if your system is contaminated with a virus, and to ensure that any areas of deleted data on the

image are not overwritten by your operating system.

Mounting an image

1. Select an unmounted image from the Installed Disk Images list in the Working With Disk Images screen. An unmounted
image has no drive letter assigned to it. When you select an unmounted image, the button labeled Mount in the toolbar
becomes active and the buttons labeled Unmount and Reassign are disabled.

2. Select on the button labeled Mount. A drive letter appears in the right-most column on the list. The button labeled Unmount
becomes active and the button labeled Mount is disabled.

Unmounting an image

1. Select a mounted image from the Installed Disk Images list in the Working With Disk Images screen.

2. Select the button labeled Unmount. The drive letter disappears. The button labeled Mount becomes active and the button
labeled Unmount is disabled.

TIP: Double-click on any installed image name to toggle its Mounted status.
g Double-click a mounted image to unmount it.
g Double-click an unmounted image to mount it.
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Emergency Disk Images: Assigning a new drive letter to an image

By default, the Disk Image Wizard assigns the first available drive letter to a new image. You may want to assign a different letter
to make it easier to remember, to maintain your shortcuts, or to allow the use of an external drive with a pre-assigned drive letter.
You can use the Working With Disk Images screen to assign any available drive letter to an image.

1.  Select the mounted image that you want to reassign in the Installed Disk Images list in the Working With Disk
Images screen.
Select the button labeled Reassign in the toolbar.

3. Choose the drive letter you want to assign from the drop-down menu.

The new drive letter appears in the Drive Letter column in the Installed Disk Images list.
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Using Emergency Disk Images: Relocating an image

By default, disk images are stored in the My Documents folder. You can move an image file (called <ImageName>.img) to
another location. If you are running out of space on the partition holding your disk images, you can move any image to any
location that has enough space available.

NOTE: Relocating a sparse image file from an NTFS-formatted partition to a FAT-formatted partition will decompress the image
file. Make sure you have enough room to store all your files.

Select the image file you want to move in the Installed Disk Images list in the Working With Disk Images screen.

Select the button labeled Relocate in the toolbar.

3. Astandard Save dialog appears. Use the drop-down menu to change folders. You can also change the file name using
the Save dialog.

4. Select the button labeled Save to move the image file to the selected folder.
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Using Emergency Disk Images: Deleting an image
If you no longer need the data contained on a disk image, and do not expect to need it in the future, you can delete the image.
1. Before deleting an image, make sure the image does not contain any files that you will need later. It is very difficult to

recover individual files from a deleted image. Mount the image, if necessary. use Windows Explorer. If you find any
files that you wish to keep, copy or move the files to another location.

. Select the disk image in the Installed Disk Images list in the Working With Disk Images screen.
3. Select the button labeled Delete.
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Using Emergency Disk Images: Editing image information

To edit the settings for an image, perform the following steps:

Select the image you want to edit in the Installed Disk Images list in the Working With Disk Images screen.
Select the button labeled Edit. A dialog appears.

To change the image name, type the new name in the field labeled Disk Image Name.

To change the image description, type in new information in the field labeled Image Description.

If you want the image to mount as a CD or DVD, select the button labeled This Image is a CD or DVD.
Select the button labeled OK.
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Order form

You may use this order form for faxing or mailing orders for Search and Recover. To print this form, select File>Print Topic.
Fax To: 1-626-793-1554 or call iolo toll-free at 1-877-239-4656 (US) or 1-626-793-3993 (non US).

ALL relevant information below is required to process your order.

Company Name (if applicable):

Your Name:

Phone Number: FAX Number:

E-Mail Address (please verify!):

Street Address:

City: State/County: Zip/Postal:

Where did you obtain System Shield?

| would like to purchase:

Copy(s) of Search and Recover at $39.95 per copy or priced according to the multi-computer matrix if more than 4
copies.

Delivery Method (check all the apply):
[ 1 E-Mailed Invoice with User ID and Serial number: FREE
[ 1 Postal delivery: $10.00 for US orders, $15.00 all others. Please allow up to 10 days for US and 20 days for all others.

| would like to pay using:
[ 1 MasterCard / Eurocard [ 1 Visa [_] American Express [ ] Discover

Name on Card:

Credit Card Number: Exp:

[ 1 I'am enclosing a check or money order paid in US Dollars, drawn on a US Bank, and payable to iolo technologies,
LLC.

Please FAX to (626) 793-1554, or mail to 145 N. Sierra Madre Blvd., Suite 1, Pasadena, CA 91107

There is a $20.00 processing fee for company purchase orders under $100.00 requesting net payment terms. Checks or
money orders must be paid in US dollars and drawn on a US Bank. Orders are processed Monday through Friday, excluding
US holidays. Please allow 24 hours for order processing. Prices and availability are subject to change without notice.



Using the Advanced Deleted File Search: Adding a location to a search

Select the button labeled Add Location in the tab labeled Locations in the Search Options dialog to include a specific folder in
your search.

1. Type in the folder path yourself or select the folder-icon button to browse to the folder.

If you have added this location in the past, use the drop-down menu to select it again.

2. By default, Advanced Deleted File Search includes all subfolders in the search scan. Deselect this button to search
only the specified folder.

3. Select the button labeled Add. The location will always appear in the lower pane, with a selected button next to it.

Leaving an Added Location out of a search

If you do not want to include this location in future searches, deselect the button.
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More about Search and Recover

Search and Recover offers a range of benefits and capabilities.

Turn back the clock

How many times have you deleted something, only to realize it was the wrong thing — a moment too late? In most cases, your
only option is to accept the loss (and try to be more careful next time).

With Search and Recover, you can instantly find and recover anything that has deleted from your system — even days, months,
or years after the Recycle Bin has been emptied!

Find it fast

Are you looking for one particular file that was accidentally deleted three weeks ago? Are you searching for a single lost
document that had an important client’s telephone number in it? Do you want to preview all of the recoverable pictures on a
certain drive?

No problem. Search and Recover provides unrivaled data searching flexibility, letting you drill down and quickly find what you are
looking for. It even lets you search within the contents of deleted items, and preview those items, so you know exactly what it is
you are recovering.

If all you need is a phone number from a certain document, just preview the deleted document’s contents, and write down the
number — it’s that easy.

Do the impossible

Prove the experts wrong when they tell you that practical recovery is hopeless. With Search and Recover, no recovery is
impossible. Advanced, unique technology lets you salvage even severely damaged items. Search and Recover finds and
recovers a much wider variety of files than competing products, from an unrivaled list of devices and locations. Search and
Recover lets you perform recovery tasks that used to require the services of a full-blown forensic science laboratory, and wraps
that capability into an easy-to-use interface that anyone can master.

Eliminate backup hassles

Backups are a necessary and integral part of computer ownership. But most people would agree that backups are also a major
headache — especially when you’ve lost something specific that you want to recover. Search and Recover provides a convenient
safety net that can let you avoid the complications of traditional backups. Instead of fumbling with awkward backup equipment
and restoration software, simply search for and recover the lost items directly from your "live" data.

Unmatched feature list

Search and Recover is unsurpassed in its rich and powerful feature set. A number of capabilities previously believed to be
impossible are provided in this powerful toolset. Capabilities such as individual recovery of email from all major mail applications,
including Outlook (even tasks, contacts, notes and calendar), Outlook Express, Netscape, and Eudora, are now possible.
Recovery of deleted music from MP3 players, pictures from digital cameras, and files from devices with removable media cards
is now easy for anyone to do.

Powerful functions in an easy-to-use interface

With all the power provided in Search and Recover, it would be natural to assume that only an expert should use this software.
Yet the product has been specially engineered for anyone to use, whether they are a beginner or a PC guru. The product
satisfies a natural requirement of computing: getting accidentally deleted data back. In addition to providing a sophisticated and
multifaceted search interface for experts, an easy "Rescue Wizard" tool is available for beginners, or for anyone who simply
wants a quick three-step recovery solution.

Bonus security tools

The need for extra security is more important now than ever before. With the increase in Internet-based threats, hacker attacks,
electronic data incursions and identity thefts, it is crucial that you secure sensitive information properly. Search and Recover
provides powerful security features that let you fight cyber-terrorism and information theft. A powerful File Terminator utility
integrates directly into Windows Explorer and lets you securely delete any existing file or folder on any drive or partition on your
system. File Terminator can overwrite a file up to 100 times, rendering the file unrecoverable by any means.

In addition to the File Terminator, Search and Recover lets you perform powerful "clean and sanitize" functions on any individual
deleted items that are found, preventing other file recovery tools from finding them. Using Search and Recover’s security tools,
you can be certain that deleted files are deleted for good.
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System requirements
In order to run Search and Recover, your computer must meet the following minimum system requirements:
g Windows 95, 98, Me, NT4, 2000, or XP

g 5 Mbytes of free hard disk space
g 64 Mbytes of RAM
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Drive

A drive is a physical data storage device: for example, a hard drive, floppy disk, Zip disk, or digital camera MemoryStick™.



Partition

A partition is a section of a hard drive. Hard drives that hold gigabytes of data often contain multiple partitions to make clusters
smaller and to help organize the data. In Windows, every partition has a drive letter.



Inclusive Search

An inclusive search identifies items that match your search criteria and includes them in your search results. For example, "Find
all files containing the text 'Bowser eats kitty chow' and display those."



Exclusive Search

An exclusive search identifies items that match your search criteria and excludes them from your search results. For example,
"Find all the .doc files with a Read-Only attribute, BUT if any of them contains the text '‘Bowser', leave that out of my results."



Next button

Select the button labeled Next to proceed to the next screen in a wizard. Be sure to read any prompts or warnings provided on
the wizard screen.



Recover Selected Items button

Select the Recover Selected Items button to recover an item that you have selected in a Search and Recover screen.



Help

Select the button labeled Help, or select the Help menu and then select the item labeled Contents, in order to view this online help
document.



Using Emergency Disk Images: Sparse images

When you create a normal image file, the Disk Image Wizard builds an image file that is large enough to contain the specified full
size of the image (even though that image does not yet contain any of your files). For example, if you create an image that is 500
Mbytes in size, the image file is a 500 Mbyte file. It takes up 500 Mbytes of hard disk space even if you do not move any files to
that image.

However, if you create your image using a "sparse file," your sparse image file takes up only the amount of space needed by the
actual files contained within the image. Any regions of zeros (empty space) in the sparse image are ‘left out’ of the sparse image
file.

To use sparse image files, you must have an NTFS-formatted drive. NTFS manages sparse files by tracking the starting and
ending point of the sparse file, as well as its useful (non-zero) data. The unused (zero data) space in a sparse file is left
unallocated, making it available as free space on your hard drive. An application accessing the image sees these unallocated
regions as containing bytes with the value zero, but there is actually no disk space used to represent those zeros.

Initially, a sparse image file will be very small. For example, if you copy 50 Mbytes of data to an image that is 500 Mbytes in size,
the sparse image file will be only slightly larger than 50 Mbytes on your hard drive.

It is much easier for your system to retrieve and open a file within a sparse image. Windows does not have to load the entire
image file (including all the empty portions of the image) in order to access only a small portion of the image (for example, a
single document file).

Return to Emergency Disk Images
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Selecting a folder location

Folder location: Type the full path of the folder you want to add, or select the folder icon to the right of the field to browse
through your system.

Scan subfolders: Select this button to include any subfolders in this branch in your search.



Wildcards
Wildcards are stand-ins for letters in file names. Use * to represent multiple letters, or ? to represent a single letter.

Example 1

The text pattern *.doc matches all files with file names ending in .doc. The files plans.doc, report.doc, and story.doc all match
this pattern.

Example 2
The text pattern s?? matches all files with file names that are three letters long and start with an s.



Cluster

A cluster is the basic unit of data storage, composed of one or more sectors on a drive.



Troubleshooting

If your File Pane is black

If you are using unusual color settings in Windows, this may affect how the windows and panes appear in Search and Recover.
The File Pane may appear black even though other Windows screens do not.

If your File Pane’s background is black and you have trouble viewing files and folders, reset your Windows colors to their default.
(Open your Display control panel and use the Appearance pane to reset your colors.)

When you cannot recover a deleted file

If you cannot recover a deleted file, find other media (hard drives, floppy disks, or removable cartridges) that may have been used
to move or temporarily store the file. Execute an Advanced Deleted File Search on those media to try to recover an alternate
copy of the desired file.
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Feature list

g Easily find and recover deleted, damaged, or destroyed files, folders, email, songs, pictures, videos, applications,
critical system components, web pages, and much more!

g Recover deleted or lost pictures, songs, and files from digital cameras, MP3 players, USB flash drives, and all other
similar devices.

g  Works with all Windows operating systems, devices, and formats:
o  Windows 95, 98, Me, NT4, 2000, and XP
o  All hard drives (IDE, SCSI, USB, FireWire, etc.)
o  All Windows formats (FAT12, FAT16, FAT32, and NTFS)
o  All portable digital media such as SmartMedia cards, memory sticks, USB flash drives, etc.

g Resurrect deleted email.

o Works with:
8§  Outlook Express
§  MS Outlook

8§  Netscape Email
§  Eudora Email
o Recovers:
§ Deleted email messages (even after removal from the "trash" folder)
§ Deleted email attachments
§ In MS Outlook: Deleted Calendar, Deleted Contacts, Deleted Notes, and Deleted Tasks.

g Eliminates the need to load backups when data is accidentally lost
g Bonus security features:

o  Quickly and securely delete any existing file or folder on your system, keeping private data out of unwanted
hands.

o  Securely delete any deleted information that Search and Recover can find, ensuring that no other recovery
tools can find it.

g Create emergency disk images:
o  Create an exact copy of all data on a drive or partition, and save it to a single file for later safe processing.

o  Use disk images as the ultimate backup tool: All data, including lost, deleted and damaged files, is backed
up and ready for use at any time.
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About this help file

This help file contains information that may be helpful to users of Search and Recover. Additional documentation, FAQs, customer
support and a knowledgebase are provided on the iolo technologies website: www.iolo.com.



Using the Advanced Deleted File Search: File menu

The File menu in the Advanced Deleted File Search screen provides the following commands:
g Print Raw Contents
Print Selected Image

Print Text In Selected Item

Printer Setup
Exit

o O o o
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Using the Advanced Deleted File Search: Edit menu

The Edit menu in the Advanced Deleted File Search screen provides the following commands:

q
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Select All Displayed ltems

Reverse Current Selection

Copy Selected Raw Text To Clipboard

Copy Selected Hex Values to Clipboard

Copy Selected Preview Data to Clipboard

Copy Picture Contents To Clipboard

Select All Displayed Preview Data

Return to Advanced Deleted File Search
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Using the Advanced Deleted File Search: Recover menu

The Recover menu in the Advanced Deleted File Search screen provides the following commands:
g Selected ltem
All Items In Selected Folder

q
g Save Picture As
g Save Raw Contents

Return to Advanced Deleted File Search
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Using the Advanced Deleted File Search: Options menu

The Options menu in the Advanced Deleted File Search screen lets you view or change the options for Search and Recover.
Select the Options menu, and select the item labeled Edit General Options, to open the General Options dialog.

Return to Advanced Deleted File Search
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Using the Advanced Deleted File Search: Security menu

The Security menu in the Advanced Deleted File Search screen lets permanently remove deleted files from your hard drive or
media. Select the Security menu, and select the item labeled Clean and Sanitize Selected Entries to remove deleted files.
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Recovery Tool Windows menu

The Recovery Tool Windows menu provides the following commands:
g Advanced File and Folder Recovery
g Email Recovery

o  Outlook Express

o  Netscape
o  Eudora
o Outlook
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Help menu

The Help menu provides the following commands:
g Contents
g About

Return to Advanced Deleted File Search
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Print Raw Contents

Select the Print Raw Contents submenu in order to access the following commands:
Current Cluster Select to print the raw data from the currently viewed cluster.
Cluster Range Select to print the raw data from a specified range of clusters.
Entire File Select to print the raw data from the entire file across all clusters.

Print Preview Select to see a preview of how the raw data will appear.



Print Selected Image

Select Print Selected Image in order to print the image contained in the currently selected file.



Print Text In Selected Item

Select Print Text In Selected Item in order to print any text in the currently selected file or message.



Printer Setup

Select Printer Setup to open the Printer Setup dialog in order to view or change your default printer settings.



Select All Displayed Items

Select Select All Displayed Items to highlight all the items in the currently active list or pane.



Reverse Current Selection

Select Reverse Current Selection to toggle your selections in the list, selecting items that were previously deselected, and
deselecting items that were previously selected.



Copy Selected Raw Text To Clipboard

Select Copy Selected Raw Text to Clipboard in order to add the raw text shown in the Viewer Pane to the clipboard so you can
paste it into another application.



Copy Selected Hex Values to Clipboard

Select Copy Selected Hex Values to Clipboard in order to add the hex or ASCII data shown in the Viewer Pane to the clipboard
S0 you can paste it into another application.



Copy Selected Preview Data to Clipboard

Select Copy Selected Preview Data to Clipboard in order to add the data shown in the Viewer Pane to the clipboard so you can
paste it into another application.



Copy Picture Contents To Clipboard

Select Copy Picture Contents to Clipboard in order to add the picture shown in the Viewer Pane to the clipboard so you can
paste it into another application.



Select All Displayed Preview Data
Select Select All Displayed Preview Data to highlight all the data in the Viewer Pane.



Exit

Select Exit in order to close Search and Recover.



Using the Advanced Deleted File Search: Search menu

The Search menu in the Advanced Deleted File Search screen provides the following commands:

q
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Start New System Search

Modify Search Filter For Currently Displayed ltems

Rescan Currently Displayed Locations

Search For File And Folder Names

Find Text In Contents Of Found Files

Find Next
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Start New System Search

Select Start New System Search in order to begin a new search, abandoning previous search results and criteria.



Modify Search Filter For Currently Displayed Items

Select Modify Search Filter For Currently Displayed Items to make changes to the search criteria used to find the currently
displayed items.



Rescan Currently Displayed Locations

Select Rescan Currently Displayed Locations to search again through the previously selected locations, re-using the same
search criteria. (This may identify additional deleted files, if there has been activity in your file system since your last search.)



Search For File And Folder Names

Select Search For File And Folder Names to find the names of files and folders that have been deleted from the selected
locations.



Find Text In Contents Of Found Files

Select Find Text In Contents Of Found Files to search through the contents of deleted files that have been identified by the
Advanced Deleted File Search, in order to locate a specific string of piece of data.



Find Next

Select Find Next to find the next matching string or piece of data within the contents of deleted files that have been identified by
Advanced Deleted File Search.



Selected Item

Select Selected Item to recover only the item you have selected.



All Items In Selected Folder

Select All Items In Selected Folder to recover all the items that appear in the selected folder.



Save Picture As

Select Save Picture As to save the recovered picture as an image file, and then select a format from the submenu that appears. A
Save File dialog appears.



Save Raw Contents

Select the Save Raw Contents submenu in order to access the following commands:
Current Selection To File Select to save the currently selected raw data to a file.
Displayed Cluster To File Select to save the currently displayed cluster to a file.
Cluster Range To File Select to save a range of clusters to a single file.

A Save File dialog appears.



Extension

In a file name, the extension is the set of 2-4 letters that follows the last period in the name (for example, .doc, .xs, .txt, or .html).
Windows uses a file’s extension to determine how to manage the file, and which application to use when the file is opened from

within Windows Explorer.



Advanced File and Folder Recovery

Select Advanced File and Folder Recovery to open the Advanced Deleted File Search screen.



Outlook Express

Select Outlook Express to open the Recover Deleted Outlook Express Mail screen.



Netscape

Select Netscape to open the Recover Deleted Netscape Mail screen.



Eudora

Select Eudora to open the Recover Deleted Eudora Mail screen.



Outlook

Select Outlook to open the Recover Deleted Outlook Mail screen.



Contents

Select Contents to open Search and Recover’s online help and documentation.



About

Select About to view the Search and Recover About pane, which provides information about the version of Search and Recover
that you are using.



Filter Condition

Select the Filter Condition button on the Advanced Deleted File Search screen to view a submenu of filter options.



Using the Advanced Deleted File Search: Menus

The Advanced Deleted File Search screen provides the following menus:
File menu

Edit menu

Search menu

Options menu

Recover menu

Security menu
Help menu
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NTFS

NT File System (NTFS) is a type of formatting used on certain Microsoft Windows systems. NTFS supports a number of features
that are not supported by File Allocation Table (FAT) formatting, including file access control. Search and Recover’s sparse image
file feature works only on NTFS-formatted drives.



Using Emergency Disk Images: Disk Manager system tray icon
The Disk Manager icon in the system tray lets you open the Disk Manager screen, close the Disk Manager service (which will
unmount all mounted images), or select an image that you wish to mount.

To access Disk Manager commands, right-click on the Disk Manager icon in the system tray. A context menu appears.

To open the Working With Disk Images screen in order to manage or open disk image files, select the item labeled Disk Image
Manager.

To mount an image file that appears in the context menu, select the image name.

To shut down the Disk Image Service (unmounting all mounted images), select the item labeled Shut Down Disk Image
Service.
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Tips for successful email recovery

To make the recovery of email more likely to succeed, prepare in advance:
g Do not compact or compress mailbox files unless you need space, and are sure that there are no deleted messages
that may require recovery. (For example, in Outlook, do not select the Compact Now option.)
g Disable the automatic compression or compaction of mailbox files.
o In Outlook Express, select the Tools menu, and then select the item labeled Options. In the dialog that
appears, select the tab labeled Maintenance. Deselect the automatic compaction option.
o In Outlook, disable the Auto Archive option.

o In Netscape (version 7 and later), select the Edit menu, then select the Preferences submenu and select
the item labeled Offline & Disk Space. Deselect the button labeled Compact folder when it will save over
XXX KB.

o In Eudora, check the Help file for instructions to disable mailbox compaction.
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Licensing Search and Recover for more than one computer

Search and Recover is licensed on a "per-computer” basis. This means that you must purchase a license for each separate
computer that it will be installed or used on, regardless of the number of people using each computer. Licenses are only sold in
the blocks designated below. If you require a number of licenses that is not defined specifically in the blocks below, you should
combine smaller blocks to arrive at an appropriate number of licenses (for example, 200 licenses would require two 100-license
blocks). Licenses for any less than five PCs are sold at single-user prices. If you require assistance before making a decision
on a multi-computer license, please do not hesitate to contact us toll-free at 1-877-239-4656 or at sales@iolo.com.

Search and Recover, single computer license: $39.95

Search and Recover Multi-Computer Pricing Matrix

Number of Users License Price

Upto5 $149.95

Up to 10 $269.95

Up to 25 $599.95

Up to 50 $1,039.95

Up to 100 $1,499.95

Up to 250 $3,295.95

Up to 500 $4,499.95

Up to 1000 $6,999.95

1001+ Contact us for special pricing.

Click here to purchase now using secure online ordering
Click here for other payment options

* Note: Prices and availability are subject to change without notice.
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